
  

FUNDAMENTALS OF COMPUTER 
 

 

After completing this lesson, you will 
be able to: 

This is 10 periods Chapter 
including practical work. 

 Know about the evolution of computer 

 Describe brief history and generations of 

computer 

 Define the types of computers (Analog, 

Digital and Hybrid) 

 Differentiate between mainframe, mini and 

microcomputers 

 Describe the use of computers in various 

fields 

 Know the scope of the careers in the field of 

Information Technology 

 Describe the components of computer 

(input/output devices, system unit and  

 

computer memory) 

 Differentiate between port, expansion slot and expansion card 

 Explain the input/output, processing and storage operations 

 Define operating system, device drivers, utility programs and language processors 

 Identify the use of productivity, business, entertainment and education software 

 Elaborate open source software, shareware and freeware 

 
UNIT INTRODUCTION 

This Unit “Fundamentals of Computer” covers a foundational understanding of computer 

hardware and software along with how to get the most value and impact from computer 

technology. In this unit the history of computer is described so that students can understand how 

have computers evolved from very simple calculating devices to the modern electronic 

computing. It also provides material on application of computers in various fields to describe the 

role of computer in modern society and its impact on our daily life. 
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TITBITS 

Abacus is still seen at some toy shops, 

made of plastic or wood for small 

children. 

1.1 INTRODUCTION TO COMPUTER 

Today’s world is an information-rich world and it has become a necessity for everyone to 

know about computers. A computer is a general-purpose programmable machine. Computer is 

  Fig.1-1 Computer processing system  
 

an advanced electronic device that takes raw data as input from the user and processes it under 

the control of set of instructions (called program), gives the result (output), and saves it for future 

use. It has the ability to store, retrieve and process data. It processes data at very high speed 

according to the instructions given to it and produces accurate results. The instructions given to 

a computer to perform a particular task is known as computer program. Computer processing 

system is shown in Fig.1-1. 

1.1.1 EVOLUTION OF COMPUTER 

Evolution of computers means how the computers evolved from the first mechanical 

device, abacus, to electromechanical and then to the modern electronic digital computers. 

Abacus 

Abacus was the earliest calculating device most 

probably invented in China. 

It consisted of a wooden frame having parallel rods as 

shown in Fig.1-2. These rods had a number of wooden beads 

which could slide freely along the length of rods. While 

performing calculations, beads were moved up and down with 

fingers. Abacus was used to perform addition, subtraction, 

multiplication and division. It has been used in China and 

some other Asian countries till the end of 20th century. 

Napier’s Bone 

John Napier, a Scottish mathematician invented a 

calculating device called Napier’s Bone in 1614 which is 

shown in Fig.1-3. It consisted of a wooden box containing 

rotating cylinders each of which had the digits from 0 to 9. 

It could multiply, divide and find square roots of numbers by 

using simple addition and subtraction. His biggest 

achievement was the invention of logarithm. 
 

  Fig.1-3 Napier’s Bone  

Fig.1-2 Abacus 

Computer 

Output Process Input 
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  Fig.1-5 Analytical Engine  
 

  Fig.1-6 Hollerith Desk  

 
Hollerith  Desk,  Hollerith started 

Pascaline 

Blaise Pascal, a French mathematician invented a 

calculating machine called Pascaline in 1642 when he was 

only 19 years old. Pascaline used rotating wheels as shown in 

Fig.1-4. Each wheel had ten parts having digits from 0 to 9. 

Calculations were performed by the rotation of wheels. When 

one wheel completes a rotation, the next wheel moves by one 

digit. It had a number of small slots for displaying the result. It 

could perform addition and subtraction on whole numbers. 

Difference Engine and Analytical Engine 

In 1822, the English mathematician Charles Babbage 

started working on a big calculating machine about the size 

of a room. He called it Difference Engine. 

Babbage worked for many years on this machine but he could 

not complete it. Later, he came up with idea of Analytical 

Engine which is shown in Fig.1-5. He could not complete it 

because the technology was not advanced enough but he laid 

the foundation stone of modern digital computers. Today’s 

modern digital computers are based on the idea of analytical 

engine. Charles Babbage is known as the father of modern 

digital computers. 

Hollerith Desk 

In 1890, Herman Hollerith built a tabulating machine called 

Hollerith Desk as shown in Fig.1-6. This machine was invented 

to help with the census of 1890 in America. Hollerith Desk 

consisted of a card reader which sensed the holes in the 

cards, a gear driven mechanism which could count and a large 

set of dial indicators to display the results. After building a 

company by the name of Tabulating Machine Company. 

Eventually this company changed its name to International Business Machines (IBM). 

Slide Rule 

Based on the idea of logarithm, English 

mathematician, William Oughtred developed a 

device called Slid Rule in 1614. It was very 

useful for solving problems that involved 

Fig.1-4 Pascaline 

Fig.1-7 Slide Rule 
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DO YOU KNOW? 

Slide rule was replaced by electronic 

pocket calculator in the early 1970s. 

multiplications and divisions. It has three parts, slide, rule 

and a transparent sliding cursor as shown in Fig.1-7. 

Mark-I 

The next successful computing machine 

invented was a digital computer known as Mark- 

I. It was invented by Howard Aiken in 1944. Mark- 

I could add three numbers having eight digits in 

one second. It could print out its results on 

punched cards or on an electric typewriter. Mark- 

I was 50 feet long, 8 feet high and weighed about 

5 tons. It used 3,000 electric switches. Mark-I is 

shown in Fig.1-8. 

More over Mark II, Mark III and Mark IV were 

also built under the supervision of Howard Aiken with extended capabilities. 

Since computer evolution is a continuous process, it has not stopped in the modern era. 

New systems are being developed to provide voice recognition and understand natural 

languages. High performance computing (HPC) is being used in today’s data centers for fast 

data processing. High-performance computing (HPC) is the use of parallel processing for 

running advanced application programs efficiently, reliably and fast. 

The concept of “Cloud Computing” has been introduced. In the simplest terms, cloud 

computing means storing and accessing data and programs over the Internet instead of 

computer's hard drive. The current advancements in computer technology are likely to transform 

computer into intelligent machine having thinking power. The evolution of computers will 

probably continue till their processing capabilities have become equal to human intelligence or 

even beyond that. 

1.1.2 GENERATIONS OF COMPUTER 

History of computers is a chain that runs from the ancient abacus and the analytical engine 

of the nineteenth century, through the modern computers of present age. It is generally divided 

into five generations. Each generation of computers is characterized by 

major technological developments of that time. 

First Generation Computers (1940 – 1956) 

Vacuum tubes were used in the first generation computers. Vacuum tubes 

generated so much heat that they had to be cooled by air conditioner. 

Vacuum tubes burnt out very often and it was difficult to repair and maintain 

the computers of first generation. A vacuum tube is shown is Fig.1-9. 

The following are the characteristics of first generation computers. 

 First generation computers used vacuum tubes. 

 Speed was slow and memory was very small. 

 They were huge in size taking up entire room. Fig.1-9 Vacuum Tube 

Fig.1-8 Mark-I Computer 
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 First generation computers were very expensive and unreliable. 

 They consumed a lot of power and generated a lot of heat. 

 Input was based on punched cards. 

 Output was obtained on printouts through electric typewriter. 

 Machine language was used in these computers. 

Some examples of first generation Mini/Mainframe computers are ENIAC (Electronic 

Numerical Integrator and Computer), UNIVAC (Universal Automatic Computer), IBM 604, Mark-I 

and EDSAC. Electronic Delay Storage Automatic Calculator. 

Second Generation Computers (1956 – 1963) 

In 1947, three scientists, William Shockley, John Bardeen and Walter 

Brattain invented transistor shown in Fig.1-10. Transistor functions like a 

vacuum tube. It replaced the vacuum tubes in the second generation 

computers. Transistor was faster, more reliable, smaller and much 

cheaper than vacuum tube. 

   Fig.1-10 Transistor  The following are the characteristics of second generation computers. 

 Transistors were used instead of vacuum tubes. 

 Transistors reduced the size of computers and increased the speed and memory 

capacity. 

 Computers became more reliable and cheaper. 

 Second generation computers used punch card readers, magnetic tapes, magnetic disks 

and printers. 

 Assembly language was used in these computers. 

 High level programming languages, FORTRAN and COBOL were introduced in this 

generation of computers. 

Examples of second generation computers are UNIVAC II, IBM 7030, 7780 and 7090, NCR 

300 series, General Electric GE 635 and Control Data Corporation’s CDC 1604 computers. 

Third Generation Computers (1963 – 1971) 

Integrated Circuits (ICs), also known as 

semiconductor chips were used in third generation of 

computers instead of transistors. IC chips were 

developed in early 1960s. A single IC chip contains a 

large number of transistors. IC chips increased the 

power and decreased the cost of computers. Invention 

of IC chips was a great breakthrough in advancing 

computer technology. IC chips are shown in Fig.1-11. 

The    following    are    the    characteristics    of third 
  Fig.1-11 IC Chips  generation of computers. 
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DO YOU KNOW? 

Intel invented the world’s first 

microprocessor, the Intel 4004 in 

November, 1971. 

 Third generation computers used IC chips. 

 IC chips improved the speed and memory of 

computers. 

 Computers consumed less electricity, became smaller, 

cheaper and more reliable than second generation computers. 

 Keyboard and monitor were used with the computer. 

 These computers could run different application programs at the same time. 

Some examples of third generation computers are Burroughs 6700, IBM System/360, 

System 3 and Control Data Corporation’s 3300 and 6600 computers. 

Fourth Generation Computers (1971 – Present) 

In this generation of computers LSI (Large Scale Integration) and VLSI 

(Very Large Scale Integration) chips having millions of transistors were 

developed. Microprocessor was also developed in fourth generation of 

computers. A microprocessor is a single chip that can handle all the 

processing of a computer. A microprocessor is shown in Fig.1-12. 

The following are the characteristics of fourth generation of computers.  Fig.1-12 Microprocessor 

 Microprocessor was developed which resulted in the development of microcomputers. 

 Fourth generation computers are very fast, have large storage capacity and use 

advanced input/output devices. 

 Microcomputers are very small in size, very reliable, consume less power and are 

affordable. 

 Large variety of software is available for use in microcomputers. 

 Operating system having Graphical User Interface (GUI) was developed in this 

generation. 

 These computers support multimedia software that combines text, image, sound and video. 

 These computers support modern programming languages such as Visual Basic, C++, 

Java and Python for developing powerful software. 

 Fourth generation computers support a large variety of portable and wireless input/output 

devices. 

Some examples of microprocessors developed in fourth generation of computers are Intel 

Pentium series, Dual Core, Core2 Duo, Core i3, i5, i7 and AMD Athlon. 

Some examples of fourth generation computers are IBM ThinkPad series, HP Pavilion 

series, Dell Inspiron series and Apple’s MacBook Pro and MacBook Air series. 

Fifth Generation Computers (Present and Beyond) 

The goal of fifth generation of computers is to develop devices that 

can understand natural languages and have thinking power. This is 

a big challenge for computer developers and programmers to design 

such systems and software for them. 

The following are the characteristics of fifth generation of computers. 

For your Information 

Artificial Intelligence is the 

branch of computer 

science concerned with 

making computer behave 

like humans. 
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 Fifth generation computes are based on Artificial Intelligence (AI). 

 In the fifth generation of computers, AI will minimize the need to write programs. 

 These computers will allow users to give commands in any natural language such as 

English. 

Examples of fifth generation computers are robots and expert systems. 

1.1.3 TYPES OF COMPUTERS 

On the basis of data representation, processing, Input and Output, Computers can be 

classified into the following three types. 

 Analog Computers 

 Digital Computers 

 Hybrid Computers 

Analog Computers 

Analog computers represent and process data by 

measuring quantities such as voltage and current to solve 

a problem. They work on supply of continuous signals as 

input and display output simultaneously. Analog 

computers are special purpose devices, designed to 

  Fig.1-13 Analog computer  perform single specific task. Mostly these devices are 

used in engineering and scientific applications. The 

accuracy of analog computers is low but they are faster in speed as compared to digital 

computers. They mainly consist of electrical devices such as resisters, capacitors, transistors, 

etc. An analog computer with volt meter is shown in Fig.1-13. 

Digital Computer 

Digital computer works with digits. Everything in a digital computer is represented with 

binary digits 0s and 1s. It manipulates them at very fast speed. Data and instructions are fed into 

the digital computer through an input device in the form of 0s and 1s. The computer performs 

calculations on data according to the 

instructions given in a computer program. The 

results of calculations are displayed on 

monitor or printed on printer. A digital 

computer is shown in Fig.1-14. 

Digital computers can store and process 

large amount of information at high speed. 

The results produced by digital computers are 

reliable and accurate. Digital computers are 

general-purpose computers, used in various 

fields. 

Fig.1-14 Digital Computer 
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Fig.1-15 A Hybrid Computer 

(Vital Sign Monitoring Unit) 

Hybrid Computers 

Hybrid computers are the combination of analog and 

digital computers. They combine the characteristics of both 

analog and digital computers. Hybrid computers are mainly 

used for scientific applications. These computers are used in 

spaceships, missile systems, scientific research, hospitals and 

for controlling industrial processes. 

A hybrid computer known as Vital Sign Monitoring Unit is 

shown in Fig.1-15. It is used in hospitals to monitor patient’s 

important data such as blood pressure, temperature, respiration 

and heartbeat. 

1.1.4 CLASSIFICATION OF DIGITAL COMPUTERS 

Digital computers are classified into super, mainframe, minicomputer and microcomputer 

based on their size, speed, storage capacity and the number of users they can support. 

Super Computer 

Super computers are the largest and the most 

powerful computers. Super computers have been used for 

scientific and engineering applications that must handle 

very large databases and do a great amount of 

computation. These computers are very expensive. Their 

speed is measured in TIPS (Trillions of Instructions per 

Second). These computers are used in nuclear research 

and forecasting weather reports worldwide. Government 

organizations use these computers to meet their extra   Fig. A-1-16 Super computer  

ordinary demand for processing data which require tremendous processing speed, memory and 

other services. Fig A-1-16 shows The Columbia Supercomputer located at the NASA Ames 

Research Center, USA. 

Mainframe Computer 

Mainframe computers were developed in early 1940s. 

A mainframe computer is a very large, very powerful and 

expensive computer that can support hundreds and even 

thousands of users at the same time. Therefore, these 

computers are used in large organizations. The modern 

mainframe computers that use cutting edge technology are 

the foundation of today’s business in banking, insurance, 
education, air travel, research, health care, government and 

many other public and private organization. These 
    Fig. B-1-16 Mainframe computer  

computers can execute more than trillion instructions per second (TIPS). Some examples of 

mainframe computers are IBM’s z Enterprise EC12, EC 196, HP 16500 Series and HP Integrity 

Superdome. A mainframe is shown in Fig.B-1-16. 
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Minicomputer 

Minicomputer was introduced in the 1960s when IC chips were introduced. A minicomputer 

is bigger than a microcomputer but smaller than a mainframe. These computers can execute 

billions of instructions per second (BIPS). 

Therefore, they can process more data than 

microcomputers. Today, minicomputers 

with cutting edge technology are playing an 

important role in business organizations for 

their data processing requirements. These 

are used in organizations that have 

hundreds of users such as PIA, NADRA, 

police departments, hospitals, etc. A 

minicomputer is shown in Fig.1-17. 

Examples    of    minicomputers    are   IBM 
  Fig.1-17 Minicomputer  

 

Microcomputer 

System/36 and HP 3000. 

Microcomputers are the smallest and the low cost computers. These computers are most 

commonly used in homes and offices. Microcomputer was introduced in 1970s when 

microprocessor was developed. A microprocessor is a single chip that controls the operations 

of the entire computer system. Modern microcomputers have large storage capacity and they 

can execute millions of instructions per second (MIPS). A variety of software is available for use 

in these computers. 

Microcomputers are available in various forms such as 

desktop, laptop and tablet as shown in Fig.1-18. Some popular 

companies that manufacture microcomputers are IBM, Dell, HP, 

Toshiba and Acer. A microcomputer is also known as Personal 

Computer or PC. IBM Lenovo series, Dell XPS series and HP 

Envy series are some popular microcomputers. 
 

 

 

 Fig.1-18 (a) Desktop (b) Laptop (c) Tablet Microcomputer 

Do you know? 

Today, microprocessor is not 

only used in microcomputers, 

they are also used in the 

devices including mobile 

phones, microwave ovens, 

cameras, washing machines, 
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1.2 ROLE OF COMPUTER 

Computer plays important role in modern society and it has changed it in many ways. It is 

the best invention ever made in the history of modern technology. It has brought advancement 

in various fields of life. 

1.2.1 USE OF COMPUTERS IN VARIOUS FIELDS 

Education 

Role of computers in education has been given a lot of importance in the recent years. 

Computer technology eases the process of learning. Many programs are available for students 

to learn the subjects of Physics, Mathematics, Chemistry, Biology, etc. Multimedia software 

makes the process of learning interactive and interesting. It combines text, graphics, sound and 

video for effective learning. Internet has enormous information on a wide variety of subjects. 

Students can refer to Internet to find information on any topic. Nowadays computers with 

multimedia projectors are being used in classrooms for effective teaching. All the activities 

related to examinations are also being controlled using computers. Therefore, it plays an 

important role in education. Today, computer education is a part of curricula from elementary to 

university level. Use of computer in education is shown in Fig.1-19. 
 

 
Fig.1-19 Use of computer in education 
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  Fig.1-20 Use of computer is business  

Business 

Computers are used in all types 

of businesses as shown in Fig.1-20, to 

improve productivity. They help in 

running business activities efficiently. 

They are used to prepare business 

documents, reports, charts, 

presentations, invoices, etc. They help 

in staying in contact with employees 

and customers. The following are some 

important business areas where 

computers are used. 

 Computer technology has revolutionized the banking business. Deposits and withdrawals 

are instantly logged into a customer’s account. Accurate monthly bank statements are 

generated with the help of computer. Computer networks allow amount of bill to be 

transferred from customer’s bank account to the store. People can obtain cash any time 

anywhere through Automated Teller Machine (ATM). 

 Computers are used in retail stores. Bar code readers are linked to computer system that 

are used to read the bar code printed on each product sold to prepare the bill. With the use 

of computers at retail stores, the checkout process is faster and the bill produced is 

accurate. 

 Electronic commerce, also known as e-commerce allows to sell products and services by 

means of computer networks such as Internet. 

 Computers are very helpful in running many other types of businesses that include hotel, 

hospital, school, travel agency, real estate, stock exchange, etc. 

Defense 

There are various applications of 

computer technology in defense. Computers 

are used in tanks, planes and ships to target 

enemy forces. They help in tracking missiles 

and destroying them. Modern defense 

weapons and other equipment are 

controlled by computers. Computers are 

used for designing and testing of weapons. 

Computers are also used in communication 

systems in defense. Fig.1-21 shows 

   Fig.1-21 Use of computer in cockpit of fighter plane  
application of computer in a fighter plane. 
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Media 

Computers have lot of applications in 

print and electronic media.   Print 

media refers to mass communication 

through printed  material. Computer 

technology helps  in preparation and 

production of newspapers, magazines, 

booklets and brochures, flyers, press 

releases and books. Electronic media 

refers to broadcast media that includes 

radio broadcast,  cable  and   satellite 

television broadcast and the new-age 

media like Internet and mobile devices. 

Computer  is used  for  television 

broadcasting as shown in Fig.1-22. 

Manufacturing 

Now days, computer technology is 

widely used in manufacturing industry. It 

has improved the accuracy, quality and 

speed of manufacturing. Computers are 

used for product design and automation of 

manufacturing process in factories as 

shown in Fig.1-23. This is known as 

Computer-Aided Design (CAD) and 

Computer-Aided Manufacturing (CAM). 

CAD involves the use of computer 

hardware and graphics software to create 

product designs. CAM involves the use of 

 

 

 

  Fig.1-23 Computer controlled manufacturing machines  

computer in planning and management of production operation. It helps in automatically 

producing finished products. CAD/CAM technology has been applied in many industries, 

including automobile, electronics, machine components, textiles, fashion, etc. 

1.2.2 CAREERS IN INFORMATION TECHONOLOGY (IT) 

Information Technology (IT) refers to anything related to computing technology, such as 

networking, hardware, software, the Internet, or the people that work with these technologies. 

Many companies now have IT departments for managing the computers, networks, and other 

technical areas of their businesses. Many jobs are offered in these departments. A few are 

discussed as below. 

Software Engineer 

Software engineer is a highly skilled person in the field of IT whose responsibilities involve 

the analysis, design, implementation and maintenance of computer software. Software engineer 

can be further classified into programmer and system analyst. 

Fig.1-22 Use of computer in television broadcasting 
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 Programmer 

Computer programmers are IT professionals who have extensive knowledge and expertise in 

programming languages. Computer programmers write programs to solve problems related with 

business, education, engineering, government offices, hospitals, entertainment, etc. 

 System Analyst 

System analysts analyze the data processing requirements of organizations and develop 

information systems to implement them. They investigate problems, plan solutions, and 

recommend the type of hardware and software required for implementing the solution. 

Hardware Engineer 

Hardware engineers design and manufacture computer hardware. Their work also involves 

repair and maintenance of computer hardware. They have in-depth knowledge of internal 

working of computers, processors, circuit boards and other electronic equipment. 

Network Administrator 

Network administrators are responsible for installation, configuration and maintenance of 

computer networks in organizations. They are in charge of maintenance of computer hardware 

and software that make up a computer network. 

Database Administrator 

Database administrator is a person who is responsible for the design, implementation and 

maintenance of a database in an organization. He is also responsible for maintaining security 

and monitoring the performance of database. 

Web Designer 

Web designer is a person whose job is to plan and create websites. He designs web pages 

that include text, images, sound, video clips and make the website interactive. HTML (Hypertext 

Markup Language) is the most commonly used language for creating websites. 

Multimedia Designer 

Multimedia designers are people who organize and present information in an easy to 

understand and attractive manner. They combine text, graphics, animation, audio and video. 

Multimedia designers create digital images and arrange them in sequence for animation using 

computer software. They have the skills to edit and manipulate audio/video files. They usually 

work in film/TV industry, computer software companies and advertising companies. 

Information Security Analyst 

Information security analyst is a person whose job is to protect information and information 

systems from unauthorized access, use, modification, recording or destruction. He implements 

procedures and policies to ensure information security within the organization. 

Computer Teacher 

Computer teacher teaches the subject of computer science to students to make them 

computer literate. He conducts lessons on how to operate computers and the working principles 

and concepts of computer hardware. He also teaches how to develop computer programs using 

various programming languages. 
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Fig.1-24 A standard keyboard 

1.3 COMPUTER HARDWARE 

Computer hardware refers to the physical components that make up a computer system. 

1.3.1 HARDWARE COMPONENTS OF COMPUTER 

Hardware components of a computer system are classified into input devices, system unit, 

storage devices, output devices and memory. 

INPUT DEVICES 

All the devices used to feed data into the computer are 

known as input devices.  Input devices  allow  us to 

communicate with the computer. Some commonly used 

input devices are keyboard, mouse, microphone, scanner, 

barcode reader, digital camera and touch screen. 

Keyboard: It is the main input device 

to communicate with the computer. It 

allows the computer user to enter 

letters, numbers and special 

symbols into the computer. A 

keyboard is shown is Fig.1-24. 

Mouse: It is a hand-held device used 

to control the movement of cursor or 

pointer on the screen. It has two or three buttons at the front that allows the 

computer user to make selection in menu, draw 

graphics or open files, folders and programs. A mouse 

is shown is Fig.1-25. 

Joystick: A joystick is a pointing device with a vertical 

lever mounted on a base. The lever usually includes    Fig.A-1-25 Mouse  

 Fig.B-1-25 Joystick  buttons called triggers, which activate certain events when pressed. 

Joysticks are mainly used for computer games. 

Microphone: It is a device that allows computer user to input audio into 

the computer. It changes audio signals into electrical signals which are 

translated into digital form by the sound card for processing in the 

computer. A microphone is shown in Fig.1-26. 

Scanner: It is a device that captures images from 

photographs, magazines, books etc. and stores 

them in computer in digital form. These images 

 
 

 Fig.1-26 Microphone 

 
 
 
 

  Fig.1-27 Scanner  

can be edited, displayed on the screen or inserted in documents. Many 

scanners also include optical character recognition (OCR) software, 

which can convert an image of text into a text file that can be edited. A 

scanner is shown in Fig.1-27. 

 
POINT TO PONDER: 

Why the keys on keyboard are 

not arranged in alphabetical 

order? 
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Barcode Reader: It is a device that reads the barcode printed on 

products that represents product code, description and price. This 

information is used by the computer to print bill for the customer. A 

barcode reader is shown in Fig.1-28. 

Digital Camera: It is a device used to 

capture pictures and store them in digital 

form. These pictures can be downloaded to 

computer for editing, viewing or inserting in 

 

 
 Fig.1-28 Barcode Reader 

 
 
 

 
    Fig.1-29 Digital Camera  

documents. A digital camera is shown in Fig.1-29. 

Touch Screen: It is a pressure-sensitive display screen that is used 

to interact with the computer by touching pictures or words with 

finger. Touch screen is more commonly used with mobile phone and 

tablet. A touch screen is shown in Fig.A-1-30. 

Touchpad: A touchpad is an input device on laptops and some keyboards to move a cursor 

with finger. As user moves finger on the surface, the mouse cursor moves in that same 

direction. A touchpad is shown in Fig. B-1-30. 

  Fig.A-1-30 Touch Screen   Fig. B-1-30 Touch Screen  

SYSTEM UNIT 

System unit is the main part of computer. It includes motherboard, power supply and drives 

(such as DVD and hard disk) inside the computer casing. All the input/output devices of a 

computer are connected to system unit through the ports. 

 Motherboard 

Motherboard is the main circuit board inside the system unit. It contains microprocessor, 

main memory, expansion cards, many IC chips, connectors and other electronic components. It 

has many buses (electric pathways) printed on it. These are used to transmit information 

between various components of the computer. All the input/output devices are connected to the 

motherboard. A motherboard is shown in Fig.1-31. 
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Fig.1-32 (a) Microprocessor (b) Block diagram of microprocessor 

(b) (a) 
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CU 
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  Fig.1-31 Motherboard  

 

 Microprocessor 

A microprocessor is the main chip on the motherboard that controls all the activities of the 

computer. It is also known as Central Processing Unit (CPU) or simply processor. It contains 

Control Unit (CU), Arithmetic Logic Unit (ALU) and registers. A microprocessor and the block 

diagram of CPU are shown in Fig.1-32. 

 

 
ALU is the part of the computer that performs all the calculations and comparisons. It consists 

of arithmetic unit and logic unit. Arithmetic unit performs all the arithmetic operations such as 

addition, subtraction, multiplication and division. Logic unit performs logical operations which 

include comparisons of numbers or alphabets. 

 

Expansion slots 

 
 

RAM memory slots 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
Socket for microprocessor 

Ports for connecting 
input/output devices 
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Control unit controls the operations of all the components of the computer. It controls the 

working of all the input/output devices, storage devices and ALU. CU loads programs into 

memory and executes them. It consists of very complicated circuits. 

Registers are small memory units inside the microprocessor used to temporarily store some 

information during the execution of a program. Some commonly used registers are Instruction 

Register, Accumulator Register, Data Register and Memory Address Register. 

STORAGE DEVICES 

Storage devices are used to store programs and data that are not currently used by the 

computer. They have huge storage capacity. Therefore, they are also known as mass storage 

devices or secondary memory. Hard disk is the most commonly used storage device that is fixed 

inside the system unit. Portable storage devices are CD, DVD, memory cards and USB flash 

drive. Portable storage devices have less storage capacity than hard disk but they are cheap 

and easy to carry. 

 
  Fig.1-33 Hard Disk  

 

 CD 

 Hard Disk 

A hard disk is a magnetic storage device used to store computer data. It 

has storage capacity of hundreds of Gigabyte (GB). It is fixed inside the 

computer casing. Portable hard disk is also available that is attached to 

USB port. 

CD stands for Compact Disk. It is a portable optical storage device with a storage capacity 

of 700 Megabytes (MB). A CD is 1.2 millimeter thick with a diameter if 120 millimeters. CD drive 

is used to read data from or write data to a CD. 

 DVD 

DVD stands for Digital Versatile Disk. It has the same thickness and 

diameter as CD but has more storage capacity. Its storage capacity is in 

the range of 4 to 16 GB. A DVD writer is installed in the computer to read 

   Fig.1-34 CD/DVD  

 

 

 Fig.1-35 Memory Card 

data from or write data to a DVD. A CD can also be used in a DVD writer. 

 Memory Card 

Memory card is a small storage device having storage capacity of 

few Gigabytes. It is available in different sizes and storage capacities. 

Memory cards are generally used in laptop computers and portable 

devices such as mobile phone and digital camera for storing pictures, 

audio and video. A memory card is shown in Fig.1-33. 
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FOR YOUR INFORMATION: 

The first high-speed printer was developed in 1953 

by Remington Rand (an early American business 

machines manufacturer) for use on UNIVAC 

computer. 

 USB Flash Drive 

USB flash drive is a small portable drive that is connected to 

computer through USB port. It is also known as USB memory. It is very 

fast in operation and its storage capacity is up to 128 GB till now. A 

USB flash drive is shown in Fig.1-34. 

OUTPUT DEVICES 

 

 

 Fig.1-36 USB Flash Drive 

Output devices are used to display text, graphics, and images on the monitor or to print 

information on paper. Information displayed on monitor is known as softcopy and anything 

printed on paper is known as hardcopy or printout. Commonly used output devices are monitor, 

printer, plotter and speaker. 

 Monito 

It is an output device that has a screen on 

which information is displayed. It has two 

common types i.e. CRT (Cathode Ray Tube) 

monitor and LCD (Liquid Crystal Display) 

monitor. CRT monitor is very similar to old 

television. It is almost obsolete due to its big 

size and low display quality. LCD monitor is 

slim, uses less power and has better display 

quality than CRT monitor. CRT and LCD 

monitors are shown in Fig.1-35. 

 Printer 

Printer is an output device that prints text and 

graphics on paper which is known as 

hardcopy. There are two types of printers 

which are impact and non-impact printers. 

Impact printer 

(a) (b) 

 

  Fig.1-37 (a) CRT Monitor  (b) LCD Monitor  
 

Impact printer uses electro-mechanical mechanism which causes the character shape to strike 

against the paper and leave an image of the character on the paper. Dot matrix printer is the 

most commonly used impact printer. The printing speed varies from 50 to 500 cps (characters 

   
(a) (b)  (c)  

  Fig.1-38 (a) Dot Matrix Printer (b) Inkjet Printer (c) Laser Printer  
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Fig.1-39 Plotter 

Fig.1-41 ROM chip 

 

per second). Their printing is very cheap but print quality is poor. They produce lot of noise while 

printing. These printers are still in use for printing invoices, bank statements, utility bills, etc. A 

Dot matrix printer is shown in Fig.1-36(a). 

Non-Impact printer 

Non-Impact printer prints without striking the paper. There are two types of non-Impact printers 

which are inkjet and laser printers. Inkjet printer stores ink in cartridge and sprays on paper 

through fine nozzles on the print-head. Laser printer uses technology similar to photocopying 

machine. Laser printer is more expensive, faster and has very high print quality compared to inkjet 

printer. Inkjet printers are used in all sectors such as homes and simple businesses. Laser printers are 

perfect for large scale businesses. Inkjet and laser printers are shown in Fig.1-36.(b,c). 

 Plotter 

Plotter is an output device used for printing engineering drawings, machine parts, building 

designs, maps, charts and panaflexes etc. on large size papers/sheets. Such large size printing 

is not possible on printers. It is more expensive than 

printer. There are two types of plotters, that is, ink plotter 

and pen plotter. Ink plotter is used for printing images 

whereas pen plotter is used for printing engineering 

drawings, machine parts, building designs, etc. Plotter is 

a slow output device but its printing quality is good. A 

plotter is shown in Fig.1-37. 

 

 

    Fig.1-40 Speakers  

 Speaker 

Speaker is a device used to produce audio output. A pair of speakers 

is attached to the sound card on the motherboard. Speakers are 

commonly used with multimedia software and for playing music and 

videos on computer. A pair of speakers is shown in Fig.1-38. 

MEMORY 

Memory unit stores data and programs that are being executed by the 

computer. It also stores the results produced by the ALU after processing the data. There are three 

types of memories on the motherboard which are ROM (Read Only Memory), RAM (Random 

Access Memory) and Cache. These are known as main memory or 

primary memory of computer. 

ROM (Read Only Memory) 

ROM is a single IC chip which is installed on the motherboard 

as shown in Fig.1-39. 

It stores the Basic Input/Output System (BIOS) of computer that 

controls input/output devices and the start-up or boot process. BIOS 
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Microprocessor 

L1 cache 

programs test the computer’s components when it is turned on and then load the operating 

system into the RAM to make the computer ready for operation. 

BIOS programs are permanently stored in ROM when it is manufactured. It is non-volatile 

memory, that is, the programs stored in it are not lost when the computer is turned off. There are 

three common types of ROM which are PROM (Programmable ROM), EPROM (Erasable 

Programmable ROM) and EEPROM (Electrically Erasable Programmable ROM). 

RAM (Random Access Memory) 

RAM is high speed memory installed on the motherboard. It is READ/WRITE memory. 

Information can be read from or written into it. Programs are loaded into RAM from secondary 

storage devices such as hard disk or USB 

flash drive for execution by the 

microprocessor. It is volatile memory which 

means information stored in it, is lost when 

the computer is turned off. 

RAM modules are installed in the 

memory slots on the motherboard. RAM 

modules are shown in Fig.1-40 

Cache Memory 

  Fig.1-42 RAM modules  

Cache is a very small amount of extremely fast memory inside 

the microprocessor or on the motherboard. It is faster and more 

expensive than RAM. It stores information that is most frequently 

used by the computer. The purpose of using cache is to improve the 

processing speed of computer. 

There are three types of cache memories which are Level 1 (L1), 

Level 2 (L2) and Level 3 (L3) as shown in Fig.1-41. L1 cache is built 

inside the microprocessor whereas L2 and L3 are on the 

motherboard. L1 cache is faster than L2 and L3 cache. 

1.3.2 PORTS, EXPANSION SLOTS AND EXPANSION CARDS 

PORTS 

Port is an interface for connecting 

various devices to the system unit. 

These are located on the motherboard 

and are usually seen at the back of the 

system unit. There are various types of 

ports for connecting keyboard, mouse, 

monitor, microphone, speakers and 

other input/output devices as shown in 
  Fig.1-44 Ports on motherboard  

Fig.1-43 L1, L2 and L3 
Cache Memories 

Main Memory 
(RAM) 

L2/L3 cache 
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STORAGE 

PROCESS INPUT OUTPUT 

Fig.1-46 Basic operations of a computer 

 

Fig.1-42(a). In modern computers, USB (Universal Serial Bus), HDMI (High Definition 

Multimedia Interface), DVI (Digital Visual Interface), Audio and LAN (Local Area Network) ports 

are used for connecting various devices to the computer. These devices include digital camera, 

scanner, printer, external hard disk or DVD writer and USB memory, etc. 

EXPANSION SLOTS AND EXPANSION CARDS 

Expansion slots are long narrow sockets on the motherboard 

used for installing expansion cards. Expansion cards are small 

circuit boards. These cards add new capabilities to the 

computers. Commonly used expansion cards are sound card, 

graphics card, modem card and network card. In modern 

computers these cards are built-in on the motherboard. A 
  Fig.1-45 Network card  network card is shown in Fig.1-43. 

1.4 BASIC OPERATIONS OF A COMPUTER 

The following four basic operations are performed by computers which are shown in Fig.1-44. 

 Input operation 

 Processing operation 

 Storage operation 

 Output operation 
 

 
 
 
 

Input Operation 

A computer is a data processing machine. Users enter data and instructions into the 

computer through keyboard or mouse. It can also be provided to the computer from a storage 

device such as hard disk, CD or USB memory. The input data/instructions are stored in memory 

for further processing. 

Processing Operation 

Microprocessor processes the data according to the instruction given to it. The microprocessor 

fetches the data/instructions from the memory and stores it in instruction register. The control unit 

then decodes the instruction to find out which operation is to be performed. After decoding the 

instruction, it sends signals to other parts of the computer to execute it. 

Storage Operation 

The results produced after processing are stored in memory before they are sent to the 

output device or permanent storage device like hard disk. 
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Output Operation 

The results of data processing stored in memory must be output so that they can be seen 

by the user. The control unit displays the results on the monitor or prints it on the printer. Results 

can also be saved in a storage device such as hard disk for use in the future. 

1.5 COMPUTER SOFTWARE 

Computer programs are known as computer software. Computer program is a set of 

instructions that tells a computer what to do and how to do. It is classified into two categories, 

system software and application software. 

1.5.1 SYSTEM SOFWARE 

System software is a collection of programs which makes the use of computer easy and 

efficient. Highly experienced computer programmers develop system software. Following are 

the types of system software. 

 Operating system 

 Device drivers 

 Utility programs 

 Language processors 

Operating System 

An operating system is system software that is responsible for the management and 

coordination of all the activities performed by the computer. It provides the environment in which 

the user can interact with the computer hardware to operate the computer. The most popular 

operating system used in microcomputers is the Windows. 

The following tasks are performed by the operating system. 

i. It loads programs into memory and executes them. 

ii. It controls the operation of input/output and storage devices. 

iii. It manages files and folders. 

iv. It allows to create password to protect computers from unauthorized use. 

v. It detects hardware failures and displays messages to fix them. 

Device Drivers 

A device driver is system software that controls the operation of a computer device. When 

users attach a device such as printer or scanner to their computer, they should install its driver 

to make it operational. Device drivers are provided by device manufacturers. 

Utility Programs 

Utility programs perform specific tasks that are related to the management of the computer. 

The following are some commonly used utility programs that perform specific tasks. 

 Windows Explorer: It is used to manage files and folders. 

 Backup utility: It is used to make backup of data. 
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 WinZip utility: It is used to compress files. 

 Diagnostic utility: It is used to detect hardware and software problems. 

 Antivirus software: It is used to detect and remove viruses. 

Language Processors 

A language processor is a system program used to translate computer programs into 

machine language. Machine language is directly understood by the computer. Therefore, all the 

programs must be translated into machine language before execution by the computer. Compiler 

and interpreter are language processors used to translate high level language programs into 

machine language. A program called assembler is used to translate assembly language 

programs into machine language. 

1.5.2 APPLICATION SOFTWARE 

Application software is developed for computer users to solve their problems such as 

preparing a letter, creating a presentation or managing a database. Commonly used application 

software includes productivity software, business software, entertainment software and 

education software. 

Productivity Software 

Productivity software includes word-processing, spreadsheet and database management 

software packages. These software packages are used by individuals to speed up their daily 

routine tasks by doing their work in an organized and efficient way. 

Business Software 

Any software that helps in running business in a more efficient way to improve 

productivity is known as business software. Some examples of commonly used business 

software are accounting, sales and marketing, inventory control, project management and 

payroll software. 

Entertainment Software 

Software developed to entertain people is known as entertainment software. Video games 

are one of the most popular forms of entertainment software. Many games are lot of fun to play 

but sometimes they can also help to improve skills such as typing or reading. The term 

edutainment merges games and education software into single software. Edutainment software 

is used mainly for entertainment but it educates as well. 

Education Software 

Software developed for educational purpose is known as education software. A large 

variety of education software has been developed. Education software includes typing tutor, 

spelling tutor, language learning, medical and healthcare, driving test and flight simulation 

software, etc. 



  31  1 Fundamentals of Computer 

 

1.5.3 OPEN SOURCE SOFTWARE, SHAREWARE AND FREEWARE 

Open Source Software 

It is computer software that is available in the form of source code that allows users to 

study, change and improve it. Open source software is free for use, modification and distribution. 

Some examples of open source software are Linux operating system, OpenOffice (office 

productivity software), Flight Gear (flight simulator) and Java programming language, etc. 

Shareware 

Shareware is distributed free of cost for a limited period, usually one or two months. It is 

trial version of software given to people to decide whether they would like to buy the full version 

of the software. Some shareware is installed on new computers when they are sold. Examples 

of shareware are antivirus software and computer games, etc. 

Freeware 

Freeware is given free of cost and it is full version of software for an unlimited period of 

time. It may have some restrictions such as allowed for personal or academic use only. 

Examples of freeware are Google Chrome, Mozilla Firefox, VLC media player, etc. 
 
 
 
 

  Key Points  
 
 

 Computer is a general-purpose programmable machine that has the ability to store, retrieve 

and process data that is represented in the form of 0s and 1s. 

 First generation computers used vacuum tubes and their period was from 1940 to 1956. 

 Second generation computers used transistors and their period was from 1956 to 1963. 

 Third generation computers used IC chips that were developed in early 1960s and their 

period is from 1963 to 1971. 

 Fourth generation computers use LSI and VLSI chips and their period is from 1971 to 

present. 

 Fifth generation of computers is concerned with development of devices that can understand 

natural languages and have thinking power. 

 Analog computer represents and processes data by measuring quantities such as voltage 

and current to solve a problem. It works on supply of continuous signals as input and displays 

output simultaneously. 

 Digital computer works with binary digits 0 and 1. Data and instructions are fed into 

digital computer through an input device such as keyboard. The computer performs 
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calculations on data according to the instructions and displays results on monitor or prints 

on printer. 

 Hybrid computer is a combination of analog and digital computers. It combines the 

characteristics of both analog and digital computers. 

 Mainframe computer is a very large, very powerful and expensive computer that can support 

hundreds and even thousands of users at the same time. 

 Minicomputer is bigger than microcomputer but smaller than mainframe. It is used in 

organizations that have hundreds of users. 

 Microcomputer is the smallest and the low cost computer. It is the most commonly used 

computer in homes and offices. 

 Software engineer is a highly skilled person in the field of IT whose responsibilities involve 

the analysis, design, implementation and maintenance of computer software. 

 Computer programmer is an IT professional who has extensive knowledge and expertise in 

programming languages. He programs the computer by writing step-by-step instructions that 

tell the computer what to do. 

 System analyst analyzes the data processing requirements of organizations and develops 

information systems to implement them. 

 Hardware engineer is an IT professional who designs and manufactures computer hardware. 

 Network engineer is a person who is responsible for installation, configuration and 

maintenance of computer networks in organizations. 

 Database administrator is a person who is responsible for the design, implementation and 

maintenance of a database in an organization. 

 Web designer is a person whose job is to plan, design and develop websites. 

 Multimedia designer is a person who designs multimedia software by combining text, 

graphics, animation, audio and video. 

 Information security analyst is a person whose job is to protect information and 

information systems from unauthorized access, use, modification, recording and 

destruction. 

 Computer teacher is a person who teaches the subject of computer science to students. 

 Computer hardware refers to the physical components that make up a computer system. 

 Computer software is a set of instructions that tells a computer what to do and how to do. 

 System software is a collection of programs which makes the use of computer easy and 

efficient. 

 Operating system is system software that is responsible for the management and 

coordination of all the activities performed by the computer. 
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 Application software is developed to solve the problems of computer users such as writing 

letter, creating presentation or managing a database. 

 Open source software is a program that is freely available in the form of source code that 

allows users to study, change and improve it. 

 Shareware is trial version of software that is distributed free of cost for a limited period, 

usually one or two months. 

 Freeware is software given free of cost for an unlimited period of time. 
 
 
 

  Exercise  
 

Q1. Select the best answer for the following MCQs. 

i. Who invented logarithm? 

A. Blaise Pascal B. John Napeir 

C. Charles Babbage D. Herman Hollerith 

ii. Which generation of computer used transistor? 

A. 1st  Generation of Computers B. 2nd Generation of Computers 

C. 3rd  Generation of Computers D. 4th Generation of Computers 

iii. In which generation of computer microprocessor was introduced? 

A. 1st  Generation of Computers B. 2nd Generation of Computers 

C. 3rd  Generation of Computers D. 4th Generation of Computers 

iv. Which of the following computer supports thousands of users at the same time? 

A. Microcomputer B. Minicomputer 

C. Mainframe computer C. Laptop computer 

v. Who is responsible for protecting information and information systems from unauthorized 

people in an organization? 

A. System Analyst B. Information Security Analyst 

C. Network Administrator D. Hardware Engineer 

vi. Which of the following is the fastest memory? 

A. USB flash drive B. RAM 

B. ROM D. Cache 
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vii. What type of software a device driver is? 

A. Application software B. Business software 

C. System software D. Productivity software 

viii.Which of the following is volatile memory? 

A. RAM B. ROM 

C. USB flash drive D. Hard disk 

ix. Which software is distributed free of cost for a limited period as a trial version? 

A. Open source software B. Shareware 

C. Freeware D. Productivity software 

x. When were IC chips developed? 

A. Early 1960s B. Early 1970s 

C. 1980s D. 1990s 

Q2. Write short answers of the following questions. 

i. Describe Napier’s Bone and Slide Rule. 

ii. Compare 1st and 3rd generation computers. 

iii. Differentiate between analog and digital computers. 

iv. Ahmed, a class IX student is asking his father to replace his home computer CRT 

monitor with LCD monitor. How will you justify his demand? 

v. What will happen if storage devices are removed from a computer? 

vi. Differentiate between systems software and application software. 

vii. How a student can use computer to improve academic performance? 

viii. Give any three uses of computers in a school library. 

ix. Name few house hold appliances in which microprocessor is used. 

x. What are the tasks performed by operating system? 

Q3. Write long answers of the following questions. 

i. Describe the five generations of computers. 

ii. Write a note on mainframe, minicomputer and microcomputer. 

iii. Explains the basic operations of a computer. 

iv. Write short note on the following. 

a. Hardware Engineer 

b. Network Administrator 

c. Database Administrator 

d. Web Designer 
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Activity 1: Demonstrate how input/output devices are connected to the system unit of the 

computer. 

Activity 2: Students should be shown components of computer such as RAM, ROM, 

microprocessor, ports, expansion slots and power supply attached to the computer system. 

e. Multimedia Designer 

v. Describe the following types of application software. 

a. Productivity software 

b. Business software 

c. Entertainment software 

d. Education software 
 
 
 
 
 
 

  Lab Activities  
 



  

FUNDAMENTALS OF OPERATING 
SYSTEM 

 

After completing this lesson, you will 
be able to: 

 Know the objectives of operating system

 Get familiar with functions of operating system

 Differentiate between common types of operating 

systems (Command Line Interface, Menu Driven 

Interface and Graphical User Interface)

 Define single user and multi-user operating systems

 Describe batch processing, time-sharing processing 

and real-time processing

 Identify the basic icons of operating system having 

graphical user interface

 Manage data (files/folders)

 Install operating system

 Install office automation software

 Install anti-virus software

This is 20 periods Chapter 
including practical work. 

 

UNIT INTRODUCTION 

Computer user must know how to give commands to the computer to operate it properly. 

Therefore, this unit is dedicated to provide basic knowledge about operating system. It teaches 

the user how to use the operating system to run programs and manage files and folders. It 

describes the steps involved in installation of operating system, office automation software and 

antivirus software in computer. It presents material about the operating system used in modern 

computers and those used in the past. This will teach the user about the advantages of modern 

operating system over the old operating systems. 

 
2 
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2.1 INTRODUCTION 

Operating system is a collection of system software that controls the working of computer 

system. It acts as an interface between the computer user and computer. It facilitates program 

execution and helps in developing application programs. 

2.1.1 OBJECTIVES OF OPERATING SYSTEM (O.S.) 

The main objectives of the operating system are convenience and efficiency. It makes the 

computer more convenient to use. It allows computer resources such as CPU, memory, 

input/output devices and Internet to be used in an efficient manner. It can be viewed as a 

resource manager. 

2.1.2 FUNCTIONS OF OPERATING SYSTEM 

The following are the main functions of operating system. 

 Process Management 

 Memory Management 

 Input/Output Management 

 File Management 

 Resource Management 

 User Management 

Process Management 

Process management is an essential part of operating system (OS). A process is a 

program in execution. In computer system multiple processes are executing concurrently or 

waiting for their turn to be executed. A process in execution needs resources like processing 

resource, memory and I/O resources. The OS must allocate resources to processes, enable 

processes to share and exchange information, and protect the resources of each process from 

other processes. 

Memory Management 

Memory management is the process of allocating memory space for user programs in main 

memory. When programs are run by users, the operating system allocates portions of free 

memory to programs. When a program is closed, operating system will free the memory portion 

used by that program for reuse. The operating system automatically loads user programs in 

available memory space and executes them. 

Input/Output Management 

Input/output management is the process of controlling the operation of all the input/output 

devices attached to computer. User communicates with computer through various input/output 

devices such as keyboard, mouse, monitor printer, etc. Management of these devices is the 

responsibility of operating system. Operating system uses Input/Output controller to manage and 

coordinate the operation of all the input/output devices. 
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File Management 

File management system is part of operating system that organizes stores and keeps track 

of computer files and folders. Computer files can be documents, programs, images, videos, etc. 

Operating system controls the common operations performed on files. These operations include 

creating, opening, editing, renaming, moving, copying, deleting and searching files. 

Resource Management 

Operating system automatically manages the resources of a computer when application 

programs are executed by computer user. The resources of a computer include microprocessor, 

memory and all the devices attached to the computer. Operating system allocates resources of 

a computer to the application program according to the user’s requirement in an efficient way to 

improve the performance of the computer. 

User Management 

User management is an important feature of operating system for maintaining a 

secure computer system. The operating system gives full control over a computer system 

to a person known as administrator. Administrator installs various programs on the 

computer system for users. He also creates and manages user accounts. When a user 

account is created, the user is assigned a user name and a password. Administrator allows 

the users to run various application programs that are installed on the computer. A user  

can login to the computer system by entering the user name and password, run programs 

and save his files in his personal folder. Operating system does not allow the users to install 

programs or create new users. 

2.1.3 OPERATING SYSTEMS INTERFACES 

There are three types of operating systems based on ways of interaction with computer 

(interface). The three types of interfaces are: 

 Command Line Interface 

 Menu Driven Interface 

 Graphical User Interface (GUI). 

Command Line Interface (CLI) 

In CLI, commands are given to computer with keyboard. It is based on textual input. The 

user types in a command and presses the Enter key to execute it. Two commonly used operating 

systems that use CLI are DOS (Disk Operating System) and UNIX. CLI is difficult to use because 

users have to remember the commands to perform any task. 

 Disk Operating System (DOS)

DOS was the most popular CLI operating system. DOS displays the prompt (C:\>) to enter 

commands. User must know the syntax of the command. DOS commands are difficult to 

remember. Some DOS commands are still supported by the new Windows operating system. It 

is a single user and single task operating system. 
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DO YOU KNOW? 

Microsoft introduced 

the MS DOS in 1981 

and it was replaced by 

Windows 3.0 in 1990. 

The following are some examples of DOS commands with their 

description 

DIR Display the contents of current directory (folder) 

FORMAT D: Format the D drive 

CD\PICS CD stands for Change Directory, which makes 

PICS the current directory 

Some DOS commands are shown in Fig.2-1. 
 

 
 UNIX

  Fig.2-1 DOS Interface  

UNIX is a multi-user CLI operating system introduced in 1969. It allows multiple users to 

run different programs at the same time. UNIX was developed for use on large computer system 
 

  Fig.2-2 UNIX Interface  
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(Mainframe). It uses a command line interface but later Graphical User Interface was also 

introduced. UNIX commands are shown in Fig.2-2. 

Menu Driven Interface 

Menu driven interface presents a menu on the screen, user makes a choice and then the 

next menu appears. The user makes 

another choice and so on. Menu 

driven interface is easy to use as 

compared to CLI. The user reads the 

options and makes his choices. 

Menus contain the commands to use 

the operating system. Menu driven 

interface is also used in some 

application programs and other 

devices such as mobile phone and 

iPod. 

The following are two common menu 

  Fig.2-3 Novell Netware Interface  

 

  Fig.2-4 ProDOS Interface  

driven operating systems 

 Novell’s Netware

Novell’s Netware was a menu- 

driven operating system that was 

used in the past. Its first version was 

released in 1993. Novell’s Netware 

interface is shown in Fig.2-3. 

 

 ProDOS

ProDOS was another menu-driven 

operating system that was used on 

some Apple computers. ProDOS 

interface is shown in Fig.2-4. 

 

Graphical User Interface (GUI) 

GUI is a graphical interface for computer users to interact with computer. It uses windows, 

icons, menus and pointer. Window is a rectangular portion of monitor in which information is 

displayed. Icon is a graphical symbol that represents a file, folder, program, device, etc. To 

perform a task, the user has to select icons or make choices in menus using a pointing device 

such as mouse. 
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Fig.2-5 Mac OS X Interface 

The following are the advantages of GUI. 

i. Much easier to learn and use 

ii. No need to memorize the commands 

iii. Allows users to run more than one program at the same time 

iv. Most of the GUIs provide good help facilities 

v. Many application programs also use a similar interface so it is easy to use a new program 

The following are the disadvantages of GUI. 

i. Takes up lot of memory. 

ii. Needs faster computer as compared to other interfaces. 

Examples of operating systems that use GUI are Macintosh, Linux and Windows. 

 Macintosh Operating System

Mac OS is a series of operating systems developed by Apple Incorporation for their 

Macintosh computers. It was introduced in 1984 with the original Macintosh computer and has 

GUI. The latest version is Mac OS X. It is a UNIX based user-friendly operating system. There 

are some specialized versions of Mac OS X used on devices such as iPhone, iPod, iPad and 

new Apple TV. Mac OS X interface is shown in Fig.2-5. 
 

 
 Linux Operating System

Linux is free open-source operating system introduced by Linus Torvalds in 1991. It is 

faster but difficult to use as compared to Macintosh and Windows operating systems. It is not a 

popular operating system. Linus Torvalds started the development of Linux operating system 

and laid its foundation. Millions of programmers around the world work on Linux to improve it 
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  Fig.2-6 Linux Interface  

Its source code is freely 

available on Internet. 

Programmers can view, edit 

and publish an improved 

version. 

Linux OS can be installed 

on PCs, laptops, netbooks, 

mobile and tablet devices, 

video game consoles, servers, 

supercomputers and more. The 

Linux OS is frequently 

packaged as a Linux 

distribution for both desktop 

and server use, and includes 

the Linux kernel (the core of the operating system) as well as supporting tools and libraries. 

Popular Linux OS distributions include Debian, Ubuntu, Fedora, Red Hat and openSUSE. Linux 

operating system interface is shown in Fig.2-6. 

 

 Windows Operating System

Windows is the most popular operating system used on microcomputers in English. It was 

developed by Microsoft. Many different versions of Windows operating system were developed 

and used successfully in the past. Some of these versions are Windows 95, Windows 98, 

Windows Millennium, Windows XP, Windows Vista, Windows 7, 8 and 10. The latest version is 

Windows 10. Windows 10 interface is shown in Fig.2-7. It is also operatable in Urdu Language. 
 

  Fig.2-7 Windows 10 Interface  
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2.2 OPERATING SYSTEM 

2.2.1 CLASSIFICATION OF OPERATING SYSTEM 

Operating systems can be classified into two major categories, single-user and multi-user 

operating systems. 

Single-user Operating System 

Operating system that is used by a single user at a time is known as single-user operating 

system. 

 It allows a single user to login and use the computer at a time. It is easy to use. 

 Resources of the computer, such as CPU, memory and input/output devices are not shared 

with other computers. 

 It is used on microcomputers. 

 User can open many programs at the same time and switch among them as required. 

 It requires less memory and costs less. 

 Some examples of single-user operating systems are DOS, Windows 95, Windows XP, 

Windows 7, etc. 

Multi-user Operating System 

Operating system that allows many users to use a computer at the same time is known is 

multi-user operating system. 

 It allows many users to login to a single big computer and run different programs at the 

same time. 

 It shares the resources of the computer with other users over the network. 

 It is used on minicomputers and mainframes. 

 Users can communicate with each other and share files. 

 A person known as administrator is responsible for assigning and managing user names 

and passwords. 

 It requires a powerful CPU, large memory and large hard drives. 

 It supports multiprogramming and time-sharing. 

 Windows NT, UNIX and Linux are popular multi-user operating systems. 

2.2.2 TYPES OF OPERATING SYSTEMS 

There are three types of operating systems. These are batch processing, Time-sharing 

and real-time operating systems. 

Batch Processing System 

In a batch processing system, jobs are grouped in batches and the computer executes 

them one.by.one. When the current job terminates, the computer automatically loads the next 

job and starts executing it. Batch processing operating systems greatly improved the use of 

computer system. 
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Batch processing systems are suitable for tasks where large amount of data has to be 

collected and processed on a regular basis. For example, in credit card billing systems, all the 

data of credit card holders is collected and held until processed as a batch at the end of billing 

cycle. As another example, in examination report card system, all the data of students’ 

examinations is collected and processed as a batch for printing report cards. 

Timesharing System 

Timesharing system is a feature of operating system in which multiple users can run 

different programs on a large-scale computer. It allows many users to have access to a 

computer at the same time and share the computer’s time. In a timesharing system, the central 

processing unit is switched rapidly between the programs so that all the user programs are 

executed simultaneously. The operating systems used in minicomputers and mainframe 

computers support timesharing. Timesharing operating systems are used in organizations such 

as airline, bank, hotel, university, etc. where many users need access to the central computer 

at the same time. 

For example, hundreds of students access the university’s mainframe computer at the 

same time and they run different programs in a timesharing system in interactive mode. 

Real time Systems 

Real time operating systems must process information and produce a response within a 

specified time. These operating systems are developed for special applications. 

These are used to control industrial processes such as oil refining. Real time operating 

systems are used to supply immediate response within limited time. For example, a 

measurement from an oil refinery indicating that temperatures are getting too high might demand 

quick response to avert an explosion. 

There are a number of real-time operating systems used in military and space research 

programs. For example, real-time operating system is used to monitor the position of rocket in 

the space. Many cities are installing real-time traffic control systems to facilitate smooth flow of 

traffic at busy intersections. 

2.3 GETTING STARTED WITH GUI OPERATING SYSTEM 

A GUI Operating System provides a user-friendly interface. This makes it easier for people 

with little computer skills to operate the computer. A GUI combines four elements which are 

Window, Icon, Menu and Pointer. All the information displayed on the screen is presented inside 

a window. Small graphical symbols known as icons are used to represent files, folders, drives, 

programs and commands. Menus present various commands from which the user makes a 

selection with a pointing device. Mouse or touchpad is used as pointing device for performing 

different tasks such as selecting an option or opening a file, folder or program. 
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Fig.2-9 Computer-Icon window 

Tip: Right click a shortcut icon, 

select Properties and click Open 

File Location to know the location 

of program, file or folder to which a 

shortcut belongs. 

2.3.1 BASIC ICONS OF GUI OPERATING SYSTEM 

An icon is a small graphical symbol that represents a file, folder, application or device. There are 

some special system icons such as Recycle Bin and Computer that are kept on the desktop. 

Icon has a label at the bottom describing its name. 

The basic icons of Windows 7 are shown in Fig.2-8 and are described below. 
 

    Fig.2-8(a) Recycle Bin, (b) Computer icon, (c) Folder icon, (d) File icon (e) Program icon (f) Shortcut icons     

 

Recycle Bin 

It is a temporary place (folder) for items that the user 

deletes from the hard disk. When a file or folder is deleted 

from a hard disk it goes to the Recycle Bin. The user can 

restore it to its original location. User can also delete a file or 

folder permanently from the Recycle Bin. 

Computer Icon 

Computer icon allows the user to access the contents of computer drives and manage files 

and folders. When user double-clicks on Computer icon, it will open a window similar to the one 

shown in Fig.2-9 that displays the drives present in the computer. It is used to navigate and 

manage the computer 

resources. 

Folder Icon 

Folder icon resembles a 

physical file folder. It is used to 

store files. A folder can have 

another folder inside it which is 

known as subfolder. Folders are 

used to keep files in an 

organized manner on a storage 

device such as hard disk so that 

they can be accessed easily. 

Tip: You can delete a file from your 

hard disk without sending it to 

Recycle Bin by clicking the file and 

then pressing Shift + Delete keys. 
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File Icon 

In a GUI, files are also represented by icons. A file may contain text, image, music or video. 

Users recognize a file by its icon. Icon of a Microsoft Word file is shown in Fig.2-8(d). 

Program Icon 

Executable program files are also represented by icons. Different graphical symbols are 

used for different program icons. Program icon of Acrobat Reader is shown in Fig.2-8(e). 

Shortcut Icon 

Shortcut icons are created to access a program, file or folder quickly. They have an 

arrow at the bottom left corner and the name below it. Shortcut icon of Google Chrome is shown 

in Fig.2-8(f). 

2.3.2 MANAGING DATA (FILES/FOLDERS) 

Managing data means storing files in secondary 

storage devices such as hard disk or USB flash drive, in an 

organized way. This helps in finding files easily and quickly. 

Files are stored in folders. The Document folder in 

Windows is the default folder where the user saves files. 

File management tools of GUI operating system provide facilities to quickly and easily 

create folders and copy or move files into them. It also allows the user to delete files and folders 

that are not needed any more. 

The following are the steps to create a new folder. 

1. Go to the location where a folder is to be created. 

2. Right-click a blank area, point to New in the shortcut menu and then click Folder as shown 

in Fig.2-10. 

3. Type a name for the new 

folder and then press Enter key. 

The following are the steps to 

copy or move files. 

1. Go to the location from where 

files are to be copied or moved. 

2. Select the files to copy or 

move. 

To select consecutive group 

of multiple files or folders, create 

a selection around the outside of 

all the items by dragging the 
mouse pointer. 

  Fig.2-10 Shortcut menu to create a folder  

Tip: You can create a new folder in 

Windows Explorer by simply pressing 

the Ctrl+Shift+N keys and then 

rename it. 
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DO YOU KNOW? 

There are six different versions of Windows 7. These are Starter, Home Basic, Home 

Premium, Professional, Enterprise and Ultimate. 

To select non-consecutive group of files or folders, press and hold down the Ctrl key and 

then click each item one by one. 

To select all the items in a window, click Organize on the toolbar and then click Select all. 

3. Right-click on any selected file icon and then select copy or move from the shortcut menu 

as shown in Fig.2-11. 
 

 

 

  Fig.2-11 Shortcut menu for copying or moving files  
 

4. Go to the location where the files are to be copied or moved. 

5. Right-click a blank area and click Paste. 

The following are the steps to delete files or folders. 

1. Go to the location from where files or folders are to be deleted. 

2. Select the items to delete as describe earlier. 

3. Right-click any selected item and then click Delete in the shortcut menu. 

2.4 SYSTEM INSTALLATION 

A computer system consists of hardware and software. Before the use of computer, user 

must install the operating system and other required software. 
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2.4.1 INSTALLATION OF WINDOWS 10 OPERATING SYSTEM 

The following are the steps for installation of Windows 10 operating system. 

1. Turn on the computer and insert the Windows 10 DVD and boot the computer. Make sure 

DVD is set as the first boot device. 

2. When the screen shown in Fig.2-12 appears, select the Language, Time and currency 

format, Keyboard or input method and click Next. 

  Fig.2-12 Screen to select language and time and currency format  
 

 

3. Click Install now in the screen shown in Fig.2-13 to start installation of Windows 10. 

 

  Fig.2-13 Screen to Install now  
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  Figure 2-15  

 

 

4. Wait for a few seconds for the setup to start (Fig. 2-14). 

 

  Figure 2-14  
 
 
 

5. If you have a product key, enter it, otherwise click on Skip (Fig. 2-15). 
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  Figure 2-17  

 

 

6. Accept the license terms and click on Next (Fig. 2-16). 
 

  Figure 2-16  
 
 
 

7. Select “Custom: install Windows only ( Advanced )” (Fig. 2-17) 
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  Figure 2-19  

 

 

8. Select the drive where you want to install Windows 10 (Fig. 2-18). 

Note: Make sure the drive is formatted, if not you can format by selecting the format option 

provided. 

  Figure 2-18  
 

9. Wait for a sometime until Windows is being installed. This may take from a few minutes to 

an hour depending on the hardware of your personal computer. Once this process is 

complete, your PC will restart (Fig. 2-19). 
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  Figure 2-21  

 

 

10. Choose Windows 10 (Fig. 2-20). 
 

  Figure 2-20  
 
 

 

11. Wait for some more time (Fig. 2-21). 
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  Figure 2-23  

 

 

12. Enter a serial key, otherwise click on Do this later to skip this option (Fig. 2-22). 
 

  Figure 2-22  
 

 

13. Click on Use express settings to use the recommended settings. Alternatively you can even 

click on Customize settings to customize the settings (Fig. 2-23). 
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  Figure 2-25  

 

 

14. Wait for a few seconds more (Fig. 2-24). 
 

  Figure 2-24  
 
 
 

15. Enter a name and password to create your account (Fig. 2-25). 
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  Figure 2-26 b  

 

 

16. Wait for a few seconds more (Fig. 2-26). 
 

  Figure 2-26 a  
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17. There you go, you are finally on Windows 10 (Fig. 2-27). 

2 Fundamentals of Operating System 

 

 

 
 

 

  Figure 2-27 a  
 
 
 
 

  Figure 2-27 b  
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DO YOU KNOW? 

The first antivirus 

software was 

developed by Bernd 

Fix in early 1987 to 

remove Vienna virus. 

2.4.2 INSTALLATION OF ANITVIRUS SOFTWARE 

The following are the steps for installation of AVG Antivirus software. 

1. Download the AVG Antivirus Free Edition 

from Internet that runs on Microsoft Windows. 

2. Double-click on the installation program 

shown in Fig.2-28. 

3. Welcome screen will appear as shown in Fig.2-29. Click the Next 

button to proceed with the installation. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

  Fig.2-29 Welcome screen of AVG Antivirus  

4. License Agreement screen will be displayed as shown in Fig.2-30. Click Accept to continue 

with the installation. 
 
 

  Fig.2-30 License Agreement screen  

Fig.2-28 Icon of AVG 

Antivirus program 
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5. Select Express Install in the screen shown in Fig.2-31 and click Next. 
 

  Fig.2-31 Screen to select type of installation  
 

6. Click Next to accept the default Component Selection shown in the screen of Fig.2-32. 
 
 
 

  Fig.2-32 Screen to select custom options  
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7. Tick () the option in the screen of Fig.2-33 if required and click Finish to complete the 

installation. 
 
 

  Fig.2-33 Screen to finish the installation  
 

2.4.3 WINDOWS DEFENDER 

Windows 10 comes with Windows Defender which is anti-virus software. Now, computer 

users do not have to buy anti-virus software. When Windows 10 is installed on a computer, 

Windows Defender is also installed as built-in anti-virus software. It runs in the background and 

checks for viruses. It automatically scans programs and files that user opens or downloads. If 

any type of malware is detected, it will display warning message and recommend what to do 

next to keep the computer safe. 
 
 
 

  Key Points  
 

 Operating System is a collection of system software that controls the working of 

computer system and acts as an interface between the computer user and 

computer. 

 The main objectives of operating system are convenience and efficiency. It makes the 

computer more convenient to use. 
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 Memory Management is the process of allocating memory space for user programs in main 

memory and managing it. 

 Input/Output Management is the process of controlling the operation of all the input/output 

devices attached to computer. 

 File Management System is the part of operating system that organizes, stores and keeps 

track of computer files and folders. 

 Resource Management refers to the automatic management of resources of a 

computer by the operating system when application programs are executed by 

computer user. Resources of a computer are CPU,  memory,  input/output 

devices, etc. 

 User Management is an important feature of operating system for creating and managing 

user accounts for a secure computer system. 

 Command Line Interface (CLI) is a type of computer interface that is based on textual input. 

In CLI, commands are given with a keyboard. 

 Menu Driven Interface presents a menu on the screen and the user makes a choice and 

then the next menu appears. The user makes another choice and so on to operate the 

computer. 

 GUI is a graphical interface for computer users to interact with computer. It uses windows, 

icons, menus and pointer. To perform a task, the user has to select icons or make choices 

in menus using a mouse. 

 The operating system that is used by a single user at a time is known as Single.user 

Operating System. It is used in microcomputers. 

 Multi-user Operating System allows many users to use a computer at the same time. These 

are used on large computers such as minicomputers and mainframes. They manage a 

large number of users. 

 Batch Processing System groups jobs in batches and the computer executes them 

one.by.one. 

 Time-sharing System is a feature of operating system in which multiple users can run 

different programs on a large-scale computer. It allows many users to have access to a 

computer at the same time and share the computer’s time. 

 Real-time System must process information and produce a response within a specified 

time. It is developed for special applications. 
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 Recycle Bin is a temporary place (folder) for items that the user deletes form the hard disk. 

Deleted items can be restored if required. 

 Computer icon allows the user to access the contents of computer drives and manage files 

and folders. 

 Folder icon resembles a physical file folder and it is used to store files. 

 In a GUI files are represented by file icons. A file can be easily recognized by looking at its 

icon. It opens by double-clicking on it. 

 Program icons represent executable program files. They open when the user Double-clicks 

on them. 

 Shortcut icons are created to access a program, file or folder quickly. They have an arrow 

at bottom left corner and the name below it. 

 Managing Data means storing files in secondary storage devices such as hard disk or USB 

flash drive, in an organized way in folders so that they can be accessed easily and quickly 

when needed. 

 
 
 
 

  Exercise  
 

Q1. Select the best answer for the following MCQs. 

i. Which interface is based on textual input? 

A. GUI B. CLI 

C. Menu-driven interface D. Windows 

ii. Which of the following interface uses window, icon, menu and pointer to interact with 

computer? 

A. GUI B. CLI 

C. Menu-driven interface D. DOS 

iii. Which of the following operating system was introduced in 1969? 

A. Macintosh B Linux 

C. Unix D. Windows 

iv. Which of the following operating system must process information and produce a 

response within a specified time? 

A. Batch Processing System B. Time-sharing System 

C. Multiprogramming System D. Real-time System 
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v. Which of the following is open source operating system? 

A. UNIX B. Linux 

C. DOS D. Novell’s Netware 

vi. Which of the following user interface is the easiest one to learn and use? 

A. CLI B. GUI 

C. Menu driven interface D. DOS 

vii. Which of the following operating system allows many users to use a computer at the same 

time? 

A. Single-user operating system B. Batch processing system 

C. Real-time processing system D. Multi-user operating system 

viii. In which of the following operating system, CPU is switched rapidly between all the 

programs to simultaneously execute all of them? 

A. Batch Processing System B. Time-sharing System 

B. Real-time System D. DOS 

ix. Which of the following Windows icon allows user to access a program, file or folder 

quickly? 

A. Program icon B. Computer icon 

C. Shortcut icon D. Recycle Bin icon 

x. Which of the following Windows icon allows user to access the contents of computer 

drives and manage files and folders? 

A. Program icon B. Computer icon 

B. Shortcut icon D. Recycle Bin icon 

Q2. Write short answers of the following questions. 

i. Why operating system is important software for a computer? Give any five reasons. 

ii. Give any three objectives of operating system? 

iii. Mention few disadvantages of using DOS. 

iv. Name two operating systems which are used in modern mobile phones. 

v. What difficulties a student may face if he/she is not familiar with the operating system 

of a computer? 

vi. Define UNIX and Windows operating system. 

vii. Differentiate between single-user and multi-user operating systems. 

viii. What is meant by managing data and why is it important? 
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Activity 1: The commonly used commands for using Windows operating system should 

be demonstrated. Students should be shown how to open and close a program. The 

commands for setting date and time, adjusting resolution, changing desktop background, 

color scheme, screen saver, etc. should be demonstrated. 

Activity 2: The file management commands such as create folder, copy, move, delete, 

rename files and folders are to be demonstrated. Use of Recycle Bin should be 

demonstrated. 

Activity 3: Installation and un-installation of a program and antivirus software should be 

demonstrated to students. 

ix. What is meant by resources of computer? 

x. What types of problems may a student face if no antivirus is installed in his/her 

computer system. 

Q3. Write long answers of the following questions. 

i. Explain the main functions of operating system. 

ii. Describe the following computer interfaces. 

a) Command Line Interface 

b) Graphical User Interface 

c) Menu-driven Interface 

iii. Describe the following types of operating systems. 

a) Batch Processing System 

b) Time-sharing System 

c) Real-time System 

iv. Write notes on Macintosh and Linux operating systems. 

v. Describe the basic icons of Windows operating system. 
 
 
 
 

  Lab Activities  
 



This is 28 periods Chapter 
including practical work. 

 Manipulate and format spreadsheet 

data 

 Use Urdu editor 

data spreadsheet Represent 

graphically 



 Recognize and define word processor 

 Manage a document (Create, Open, Save, Save as, Print) 

 Edit text, show/hide Ribbon, insert symbols and use Equation Editor 

 Format text, paragraph and page 

 Insert page break, section break, header, footer and page number 

 Insert and position pictures within a document 

 Insert Word Art 

 Create table with formatting 

 Change the margins of document 

 Use Hyperlink 

 Know the basics of spreadsheet 

 Work with functions and formulas in a 

spreadsheet 

After completing this lesson, you will 

be able to: 

  

OFFICE AUTOMATION 

 
 

UNIT INTRODUCTION 

Computer users have to prepare documents in whichever profession they are. It is 

essential for all the users to learn how to create documents such as letters, reports, proposals, 

resumes, etc. Spreadsheets are also commonly required in business and office. These are used 

to store and process numeric data. Hence, all the users should have basic knowledge to create 

documents and spreadsheets. This unit describes how to prepare professional-looking 

documents and spreadsheets using a word processing and a spreadsheet program respectively. 

The last section of the unit describes how to prepare documents in Urdu with an Urdu editor. 

 
3 
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DO YOU KNOW? 

Microsoft Office 2010 cannot 

be installed on a computer on 

which Windows XP operating 

system is installed. 

3.1 OFFICE AUTOMATION 

Office Automation refers to modern technology used to create, store, process and 

communicate information for accomplishing basic tasks performed in offices. The system that 

facilitates office automation is known as Office Automation System (OAS). Office Automation 

System consists of computer hardware, software and network. The software used for office 

automation consists of word-processing, spreadsheet, database management, presentation, 

graphics, electronic mail and video conferencing software. Office automation software allows 

users to create letters, reports, spreadsheets, graphs, manipulate images and send email to or 

receive email from users on the network. Office automation software helps in improving 

productivity and saving money and human efforts. 

The most commonly used office automation software is Microsoft Office. It is an office suite 

of applications. It consists of MS Word, MS Excel, MS Access, MS PowerPoint and MS Outlook. 

It was first announced by Bill Gates on 1 August 1988. Its latest version is Microsoft Office 2016 

released on 22 September, 2015. It is also operateable in Urdu. 

Some other examples of office automation software are Apache OpenOffice, LibreOffice 

and NeoOffice. All of these are based on OpenOffice office suite. These can be freely 

downloaded and installed on Windows, Linux and MacOS operating systems. 

3.1.1 INSTALLATION OF OFFICE AUTOMATION SOFTWARE 

The common office automation software is Microsoft Office. It is productivity software for 

Windows operating system. It includes word processing, spreadsheet, presentation, database 

and e-mail communication programs. These programs provide facilities that are commonly 

required to run an office or business. 

The following are the steps to install Microsoft Office 2010 software. 

1. Run the installation program. 

2. Enter the Product Key and 

click Continue button as 

shown in Fig.3-1. 

3. Read the Microsoft Software 

License Terms shown in 
 

 
  Fig.3-1 Screen for entering Product Key  

https://en.wikipedia.org/wiki/Bill_Gates
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Fig.3-2, check the box to accept the terms of agreement and click Continue. 

 

  Fig.3-2 Microsoft Software License Terms  
 

 

4. Click Install Now button shown in Fig.3-3 to start the installation. 
 

  Fig.3-3 Screen to choose preferred type of installation  
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DO YOU KNOW? 

The first version of Microsoft Word was released in 1983 for DOS and 

first Windows version was released in 1989. 

5. Progress bar indicating how much installation has progressed will appear as shown in Fig.3- 

4. This may take several minutes to complete. 

 

  Fig.3-4 Progress bar indicating installation progress  
 
 

6. Click the Close button shown in Fig.3-5 to exit the installation program. 

  Fig. 3-5 Screen indicating that installation has completed  
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Fig.3-6 Opening Word 

Word processing refers to the use of computer to create, edit, format and print 

documents. 

Word processor is computer application software that is used for the creation of different 

types of documents on computer. 

Word processor is a commonly used application of computer. Word processor allows user to 

delete, modify and rearrange document without retyping any of the existing text. Word processing 

system has the advantage of reducing time required to prepare documents. It provides features to 

create appealing  professional 

documents. With word processing 

programs, user can create many 

types of documents such as letters, 

reports, resumes, newsletters, 

memos, flyers, etc. 

A common word processing 

program used is Microsoft Word. It 

is a part of Microsoft Office 

software. Microsoft Office contains 

word processing, record-keeping, 

spreadsheet and presentation 

software. 

Opening the MS Word Program 

The following are the steps for 

opening the MS Word program. 

1. Turn on the computer and 

click Start button. 

2. Click All Programs. 

3. Click Microsoft Office to 

display the submenu. The 

submenu contains all the 

programs included in Microsoft 

Office software. 

 
4. Click Microsoft Word 2010 to 

open the Word program shown in 

Fig.3-6. 
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Word Window 

The main components of Word window consist of Quick Access Toolbar, Ribbon, Horizontal / Vertical 

Scroll bars and Status bar as shown in Fig.3-7. 

Quick Access Toolbar 

Quick Access Toolbar is located at the top left corner of Word window. It provides easy 

access to commonly used Save, Undo and Redo commands. If the user clicks the down arrow 

at the right side, Word will display a list of commands that can be quickly added to or removed 

from the Quick Access Toolbar. 

Ribbon 

Ribbon is located below the title bar of the Word window. Ribbon consists of tabs, groups 

and commands as shown in Fig.3-8. It provides access to the commands that are performed 

while working on a document. 

There are nine types of tabs in the ribbon which are File, Home, Insert, Page Layout, 

References, Mailings, Review, View and Add-Ins. Home tab is the most commonly used tab. To 

display any of these tabs just click on it. 

Fig.3-7 Word Window 
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  Fig.3-8 Ribbon  

 

Horizontal and Vertical Scroll Bars 

Vertical scroll bar is located at the right edge of the document window. It is used to scroll 

down or up the document that is too large to fit in the document window. Horizontal scroll bar 

appears automatically at the bottom of the document window if a document is too wide to fit in 

the document window. 

Status Bar 

Status bar is located at the bottom of the document window above the Windows task bar, 

It presents information about the document such as current page, total number of pages in the 

document, number of words in the document, etc. It also provides controls for viewing the 

document in different layouts. The right edge of status 

bar presents zoom in and zoom out bar. Zoom in is 

used to get close-up view of document and zoom out 

is used to view more of the page at a reduced size. 

3.1.2 MANAGING A DOCUMENT 

Creating a New Document 

The following are the steps to create a new document. 

1. Click the File tab. 

2. Click New in the pull-down menu as shown in 

Fig.3-9. 

3. Select Blank document which is below 

Available Templates. User can also start a new 

document by selecting a template. 

  Fig.3-9 File tab  4. Click Create. A new blank document will appear 
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Another way to start a new blank document is press Ctrl+N on the keyboard. Ctrl+N means 

keep pressing the Ctrl key while pressing the N key. 

Opening a Document 

1. Click the File tab 
 

  Fig.3-10 Open dialog box  
 
 

2. Click Open. The Open dialog box as shown in Fig.3-10 will appear. 

3. Select the document and click Open. 

If the user has recently opened the document that he wants to open then he can follow the 

steps given below. 

1. Click File tab. 

2. Click Recent. 

3. Select the document from the Recent Document list. 

Saving a Document 

1. Click File tab. 

2. Click Save or Save As. 

3. Select the folder where the document is to be saved as shown in Fig.3-11. 

4. Give a file name to your document. 
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Save icon 

 

 
 

  Fig.3-11 Save As dialog box  

5. Click Save. 
 

 

 

 

  Fig.3-12 printing a document  

Save As option is used when changes have been made 

in an existing file and the user wants to save the new 

version of the document with a different file name. 

Another way to save a document is, click the Save icon 

on the Quick Access Toolbar and give the new document 

a file name. 

Printing a Document 

The following are the steps to print a document. 

1. Click the File tab. 

2. Select Print. 

3. Change the print settings shown in Fig.3-12 if 

required and click Print. 
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Tip: To search text in a 

document, press Ctrl+F, 

type the search text in the 

box and press Enter. 

3.1.3 INSERTING AND EDITING TEXT 

To insert text in a document, type it using the keyboard. The text will appear at the insertion 

point. When typing a paragraph, there is no need to press the Enter key at the end of the line. 

When the user reaches the right margin, Word will automatically position the insertion point at 

the beginning of the next line. The user should only press the Enter key when he wants to end 

a line of text, start a new paragraph or insert a blank line. Shortcut keys for cursor movement 

are shown in Table 3-13. 
 

Cursor Movement Shortcut Key 

Beginning of the line Home 

End of line End 

Top of the document Ctrl + Home 

End of document Ctrl + End 

  Table 3-13 Shortcut keys for cursor movement  

 

Selecting Text 

To move or copy words, sentences or paragraphs to another 

location in the document, first select the text and then use cut-and- 

paste or copy-and-paste technique. Commands shown in Table 3- 

14 are used for selecting various items in a document with mouse. 

 

Item to Select Mouse Command 

Characters Drag through characters 

Single word Double-click the word 

Words Drag through words 

Sentence Press and hold down Ctrl key and click anywhere in the sentence 

Line 
Move the mouse pointer to the left of the line until it changes to a right- 

pointing arrow and then single click 

Paragraph 
Move the mouse pointer to the left of the paragraph until it changes to a 

right-pointing arrow and then Double-click 

Entire document 
Move the mouse pointer to the left of the document until it changes to a 

right-pointing arrow and then triple-click 

 
Block of text 

Click at the beginning of the text to be selected. Move the mouse 

pointer to the end of the selection and hold down Shift key and then 

click or drag through the text. 

Graphic Click the graphic 

  Table 3-14 Mouse commands for selecting items  
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Copying and Moving Text 

The following are the steps to copy or move the first two sentences of the paragraph shown 

in Fig.3-15. 

  Fig.3-15 Paragraph in Word window  
 

 

1. Select the text that is to be copied or moved as shown in Fig.3-16 

 

  Fig.3-16 Text selected for copying  
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2. Click Copy or Cut in the Clipboard group of Home tab as shown 

above. 

3. Position the mouse pointer at the location where you want to copy 

or move the text. 

4. Click Paste in the Clipboard group. Copied text is shown in Fig.3- 

17. 
 

 

  Fig.3-17 Text copied at the end of paragraph after leaving one blank line  
 
 

There is another method for copying and moving text using shortcut keys. The steps for 

this are given below. 

1. Select the text. 

2. Press Ctrl+C for copying or Ctrl+X for moving text. 

3. Position the mouse pointer to the location where you want to copy or move the text. 

4. Press Ctrl+V for pasting the text. 

There is also a third method for copying and moving text. The following are the steps for 

this method. 

1. Select the text as shown in Fig.3-18. 



  76  3 Office Automation 

 

Arrow to Minimize/Maximize 
Ribbon 

 

 

  Fig.3-18 Shortcut menu for copying or moving text  
 

 

2. Right click anywhere inside the selected text to display the shortcut menu. 

3. Click Copy or Move in the shortcut menu as shown in Fig.3-19 

4. Move the mouse pointer where you want to copy or move the text. 

5. Right click and then click Paste in the shortcut menu. 

Deleting Text 

To delete text, select the text using any of the methods described earlier and then press 

Delete key. 

3.1.5 MINIMIZE/MAXIMIZE RIBBON 
 

  Fig.3-19 Minimizing or maximizing Ribbon  
 

 

To minimize the Ribbon for more screen space, click the arrow in the upper-right corner 

of the Ribbon as shown in Fig.3-19. When Ribbon is minimized, click on a tab to display it. The 

Ribbon will disappear again when it is not in use. To maximize the Ribbon, click the arrow 

again. 
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3.1.6 INSERTING SYMBOLS 

The following are the steps to insert symbols or special characters in documents. 
 

  Fig.3-20 Inserting symbols in document  
 

 

1. Click Insert tab. 

2. Click Symbol which is at the right end of ribbon. A group of symbols will be displayed as 

shown in Fig.3-20. 

3. Click the symbol that is to be inserted in document. The symbols will be inserted in the 

document as shown in Fig.3-21. 
 

  Fig.3-21 Symbols inserted in document  
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To display more symbols, click More 

Symbols in the Symbol menu. A new 

dialog box will open with two tabs, 

Symbols and Special Characters as 

shown in Fig.3-22. Now, select the symbol 

and click the Insert button. 

 

 

 
 
 

 
  Fig.3-22 Symbol dialog box  

3.1.7 INSERTING EQUATION 

Word allows user to insert common 

mathematical equations or build up his own 

equations using a library of symbols. 

The following are the steps to insert built- 

In equation. 

1. Click Insert tab. 

2. Click Equation button on the 

Symbols group. 

3. Select the type of equation you 

want to insert as shown in Fig.3-23. 

To following steps allow the user to insert 

his/her own equation. 

1. Click Insert tab. 

2. Click π button on the Symbols 

group. This will open the Design tab 

shown in Fig.3-24 that allows inserting 

common mathematical equations or build 

equation using a library of math symbols. 
 
 

 

  Fig.3-23 Inserting equation  

 

  Fig.3-24 Design tab for inserting equation  
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3.1.8 FORMATTING TEXT, PARAGRAPH AND PAGE 

Formatting Text 

Formatting text means changing the font type, size, style, color and effects of text. 

Changing the Font Type and Size of Text 

Open the Home tab 

and click the arrow on the 

right side of the currently 

selected font type as 

shown in Fig.3-25 and 

choose another font type. 

To change the font size, 

click the arrow on the 

right side of the font size 

and select a font size 

from the drop-down list or 

Font type Font size 
 

 

  Fig.3-25 Changing font type and font size  

type a new font size. To change the font type or size of existing text, select the text and 

then make the changes. 

Changing Font Styles and Effects 

The following are the steps for changing 

font styles and effects. 

1. Click the Home tab. 

2. Click the dialog box launcher on the 

lower-right corner of the Font group. 

This will open the Font dialog box 

shown in Fig.3-21. Now, the user can 

change font styles and effects of text. 

Some changes that are available in 

the Font dialog box can be made directly 

from the Font group in Home tab. 

The following are the steps to clear the text 

formatting. 

1. Select the text you want to clear the 

formatting. 

2. Click the Home tab. 

3. Open the Styles dialog box and select 

Clear all as shown in Fig.3-26. 
  Fig.3-26 Font dialog box  
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  Fig.3-27 Style dialog box  
 

 

Paragraph Formatting 

Paragraph formatting refers to change of format of text of paragraph such as font size, 

color, line spacing, alignment etc. Paragraph formatting tools are provided in the Paragraph 

group of Home tab as shown in Fig.3-27 and Page Layout tab. 

 Changing Paragraph Alignment and Indenting 
 

 

  Fig.3-28 Paragraph alignment and indenting  

Paragraph alignment refers to the 

appearance of lines in a paragraph in relation 

to left or right margins. Left align is the default 

setting for paragraph alignment. 

Paragraph indentation refers to the 

distance of paragraph from left margin. 

Select the paragraph to change the 

alignment and then select an alignment from 

the Paragraph group on Home tab as shown 

in Fig.3-28. 

 

Align left: It will align the text to the left margin. 

Center: It will center the text within the left and right margins. 

Align right: It will align the text to the right margin. 

Justify: It will align the text both to the right and left margins. 
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Fig.3-30 Page Layout tab 

To increase paragraph indent, click 

the Increase Indent button shown in 

Fig.3-23, in the Paragraph group on 

Home tab. To decrease the paragraph 

indent, click the Decrease Indent button. 

Increasing indentation will move the 

paragraph to the right side by one tab 

position. Decreasing indentation will move 

the paragraph to the left side by one tab 

position. 

 Changing Spacing between 

Paragraphs and Lines 

The following are the steps for changing 

spacing between paragraphs and lines. 

1. Select the paragraph or paragraphs. 

2. Click Home tab. 

3. Open the Paragraph dialog box 

shown in Fig.3-29 by clicking the 

small arrow at the bottom right corner 

of the Paragraph group. 

4. Make the required changes. 

5. Click OK to apply the changes. 

Page Formatting 

Page formatting refers to formatting 

 

 

  Fig.3-29 Paragraph dialog box  

that affects the entire page such as changing page orientation, margins, page numbering, 

header and footer, etc. Page formatting commands are included in the Page Layout tab on the 

Ribbon. These are in the Themes, Page Setup and Page Background groups as shown in 

Fig.3-30. 

Commonly used page formatting commands include changing theme, margins, orientation, 

page size and background. 
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 Document Theme 

Themes change the overall appearance of the entire document, including colors, fonts 

and effects. 

The following are the steps to apply a theme. 

1. Click the Page Layout tab. 

2. Click the Themes button in the Themes 

group. 

3. Select a theme to apply from the menu 

shown in Fig.3-31. If the user does not like 

the selected theme, he can select another 

one. To remove a theme from the 

document select Office theme. 

 Page Margins 

Page Margins refer to the amount of 

blank space that appears at the top, bottom, left 

and right edges of a document. 

  Fig.3-31 Applying a theme to a document  

1. Click the Page Layout tab. 

2. Click Margins button. 

The following are the steps to set margins. 

3. Select margins from the menu that appears as shown in Fig.3-32. 
 

  Fig.3-32 Setting page margins  



  83  3 Office Automation 

 

 Page Orientation 

Page orientation refers to the 

way rectangular page is oriented 

for viewing. There are two types of 

page orientations which are portrait 

and landscape. In portrait 

orientation, the height of display is 

greater than width. In landscape 

orientation, the width of display is 

greater than height. 

The following are the steps to 

apply a page orientation. 

1. Click Page Layout tab. 

2. Click Orientation button in the 

Page Setup group. 

 

 

  Fig.3-33 Applying page orientation  

3. Select Portrait or Landscape orientation as shown in Fig.3-33 

 Page Size 

Page size refers to the height 

and width of page. 

The following are the steps to 

set page size. 

1. Click Page Layout tab. 

2. Click Size button in the Page 

Setup group. 

3. Select a page size from the 

menu shown in Fig.3-34. 

 Page Background 

The Background group has 

three items to set for the document 
  Fig.3-34 Selecting a page size  

which include Watermark, Page Color and Page Borders. Watermark inserts dim text behind 

the content of the page. Page Color sets the page background color and Page Borders option 

inserts or changes the border around the page. 

The following are the steps to set watermark 

1. Click Page Layout tab. 

2. Click Watermark command in the Page Background group. 
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Fig.3-35 Creating a watermark 

3. Click Custom Watermark from the menu shown in Fig.3-35. User can also select a 

watermark that is displayed in the menu if it fulfills the requirement. 
 

4. Type the text for watermark as shown in Fig.3-36 

5. Click Apply and then click Close to close the dialog box. 
 

  Fig.3-36 Dialog box to create watermark  
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The following are the steps to set page color. 

1. Click Page Layout tab. 

2. Click the Page Color command. 

3. Select a page color from the menu shown 

in Fig.3-37 

The following are the steps to set page 

border. 

1. Click Page Layout tab. 

2. Click the Page Borders command in 

Page Background group. 

3. Select a page border style from the 

Borders and Shading dialog box shown 

in Fig.3-38 

3.1.9 INSERTING PAGE BREAKS 

AND SECTION BREAKS 

A page break is a marker that tells 

Word program that the contents which follow 

are to appear on a new page. Word 

automatically inserts a page break when the 

user reaches the end of a page. Page break 

is inserted in document when user wants to 

add a new page to the document. 

A section break also inserts a new page 

 

 

  Fig.3-37 Setting a page color  
 

  Fig.3-38 Selecting a page border style  

but it allows the user to change the page format without having any effect on the formatting of 

the previous pages. For example, section break can be 

used to break a document into sections having different 

header and footer for each chapter of a book. 

The following are the steps for inserting page break and 

section break. 

1. Click the Page Layout tab. 

2. Click the Breaks icon to open the drop-down menu 

shown in Fig.3-39. 

3. To insert a page break click the first option under the 

Page Breaks heading and to insert a section break 

click the first option under the Section Breaks 

heading. 
  Fig.3-39 Breaks drop-down menu  
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3.1.10 INSERTING HEADER, FOOTER AND PAGE NUMBER 

Header refers to information that appears at the top of a page and 

footer refers to information that appears at the bottom of a page. The type 

of information that may 

appear in the header or 

footer  includes  book title, 

document title, chapter number and title, page 

number, company name, etc. 

The following are the steps for inserting header or 

footer. 

1. Click the Insert tab. 

2. Click the Header or Footer in the Header & 

Footer group shown above to open the 

drop-down menu. 

3. Select a predesigned header or footer from 

the drop-down menu shown in Fig.3-40. 

Header or footer will appear in the document 

and the Design tab will appear in the 

Ribbon as shown in Fig.3-41. 

4. Type the information in the header or footer. 

5. After entering the information, click Close 

Header and Footer in the Design tab. 
  Fig.3-40 Inserting a header  To edit the information in the header or footer 

Double-click anywhere on the header or footer and make the changes. 
 

 

  Fig.3-41 Entering information in header  
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Inserting Page Numbers 

The following are the steps for 

inserting page numbers in 

documents. 

1. Click the Insert tab. 

2. Click Page Number in the Header 

& Footer group. A drop-down 

menu will appear. 

3. Move the mouse pointer on Top of 

Page or Bottom of Page 

command. This will open a 

submenu as shown in Fig.3-42. 

4. Select an option from the 

submenu. Page number will be 

inserted in the document and 

Design tab will appear on the 

Ribbon. 

5. Set the value for Header from Top 

or Footer from Bottom in the 

Position group of Design tab if 

required. 

 

 

  Fig.3-42 Inserting page number at the bottom of page  

6. Click the Close Header and Footer button on the Design tab. 

3.1.11 INSERTING AND POSITIONING PICTURE 

The following are the steps 

for inserting a picture in a 

document. 

1. Place the cursor where 

to insert the picture. 

2. Click Insert tab. 

3. Click Picture command 

in Illustrations group. 

The Insert Picture 

dialog box will appear 

as shown in Fig.3-43. 

4. Browse and select the 

picture file to insert and 

click Insert button. 

  Fig.3-43 Insert Picture dialog box  
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Fig.3-44 Positioning a picture within a page 

Positioning Picture within a Page 

The following are the steps for positioning picture on page. 

1. Click the picture that is to be positioned. Format tab will appear on 

the screen. 

2. Click Position command on the Arrange group. 

3. Select a position from the menu. Top right corner is selected for 

positioning the picture in Fig.3-44. 
 

4. Picture positioned at top right corner of page is shown in Fig.3-45. 

 

  Fig.3-45 Picture positioned at top right corner of page  

Tip: If you want to 

change the page 

number format, click 

Insert tab then click 

Page Number and 

select Format Page 

Numbers. 
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3.1.12 INSERTING WORDART 

WordArt is a text modifying feature in Word to 

create decorative effects such as shadow, colors, 

outlines, 3D effects, changing shape of text, etc. as 

shown in Fig.3-46. It is also 

possible to convert existing 

text into WordArt. 

The following are the steps to 

insert WordArt in a document. 

1. Click the Insert tab. 

2. Click WordArt in the Text 

group. 

3. Select character style from 

the drop-down menu 

shown in Fig.3-47. Format 

tab will appear on the 

Ribbon. 

4. Type the text in the text 

 

 

  Fig.3.46 Text created with WordArt  

box shown in Fig.3-48.   Fig.3-47 Inserting WordArt  

 
 
 

 

  Fig.3-48 Entering text in WordArt  
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Tip: Another way to insert table is, click 

Insert tab, click Table and then select 

Insert Table. Specify the number of 

rows and columns in the dialog box and 

click OK. 

5. Click Text Effects command in the WordArt Styles group. 

6. Move the mouse pointer over Transform and select a text effect from the submenu as shown 

in Fig.3-49. 
 

 

3.1.13 CREATING AND FORMATTING TABLE 

A table consists of rows and columns. The intersection of a row and a column is called a 

cell. Text is entered in the cells. Before inserting a table in a document, user should know the 

number of rows and columns required. This is called the dimension of the table. User can easily 

add more rows or columns as required. In table dimension, the first number is the number of 

columns and the second number is the number of rows. For example, a 5x4 (five by four) table 

means it has 5 columns and 4 rows. 

Inserting Table in a Document 

The following are the steps for inserting a 5x4 table. 

1. Click Insert tab. 

Fig.3-49 Applying text effect 
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2. Click Table command in the Tables group as shown in Fig.3-50. 
 

  Fig.3-50 Inserting a 5x4 table in a document  
 

3. Position the mouse pointer on the cell in the fourth row and fifth column and click. A blank 

table consisting of 4 rows and 5 columns will be inserted in the document. 

4. Now, user can enter data in the cells. 

A 5x4 table with data is shown in Fig.3-51. 

Fig.3-51 Data entered in a 5x4 table 
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Adding and Deleting Rows or Columns 

The following are the steps for adding and deleting rows or columns. 

1. To insert a row, click in the cell below or above which a blank row is to be inserted. To insert 

a column, click in the cell to the right or left of which a blank column is to be inserted. Design 

and Layout tabs will appear on the Ribbon. 

2. Click the Layout tab. 

3. Click the command in the Rows & Columns group shown in Fig.3-52 to insert a row or 

column. If you want to delete a row or column click the Delete command in the Rows & 

Columns group. Select the Delete Rows or Delete Columns from the drop-down menu. 

User can also delete the entire table by selecting Delete Table. 

User can delete multiple rows or columns by selecting them by dragging and then clicking 

the Delete command. 
 

  Fig.3-52 Adding or deleting rows and columns  
 

Resizing Rows and Columns 

Following are the steps for resizing row or columns. 

1. Click in any cell of row or column to change the height or width. 

2. Click Layout tab as shown in Fig.3-53. 
 

  Fig.3-53 Resizing row and column size  
 

3. Resize row height or column width in the Cell Size group. 

To resize multiple rows or columns, first select multiple rows or columns. Last three rows 

of table are selected for resizing in Fig.3-54. Table after resizing the last three rows is shown in 

Fig.3-55. 
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  Fig.3-54 Selection of multiple rows for resizing  
 

  Fig.3-55 Table after resizing the last three rows  
 

Adding or Changing Border Lines and Shading 

The following are the steps for adding or changing border lines and shading. 

1. Select the cells 

2. Click the Design tab. 

3. Open the Border drop-down menu in the Table Styles group and select a border as shown 

in Fig.3-56. 
 

  Fig.3-56 Changing border lines of a table  
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4. For shading, open the Shading drop-down menu in the Table Styles group and select a 

shading color as shown in Fig.3-57. 
 

  Fig.3-57 Selecting a shading color for a table  

 

Merging and Splitting Cells 

1. Select the cells for merging or splitting. 

2. Click the Layout tab. 

3. Click Merge Cells command in the Merge group as shown in Fig.3-58. Table after merging 

the selected cells is shown in Fig.3-59. For splitting cells, click the Split Cells command in 

the same group and enter required values in the Split Cells dialog box and click OK. 
 

  Fig.3-58 Selecting cells for merging  
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  Fig.3.59 Table after merging two cells  

3.1.14 CHANGING MARGINS 

The following are the steps for changing margins. 

1. Click Page Layout tab. 

2. Click Margins in the Page Setup group. 

3. Select margins from the drop-down menu as shown in Fig.3-60 or click Custom Margins 

and set the required margins in the Margins tab of Page Setup dialog box. 

4. Click OK. 

A page with Normal margins and Narrow margins is shown in Fig.3-61. 
 

  Fig.3-60 Changing margins Fig.3-61 (a) Page with Normal margins (b) Page with Narrow Margins  
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DO YOU KNOW? 

A Webpage is a document which 

can be displayed in a web browser 

such as Google Chrome, Internet 

Explorer or Edge. These are also 

often called just "pages." A 

collection of webpages are grouped 

together to from a Website. 

3.1.15 USING HYPERLINK 

Hyperlink is text in a Web page or document that links 

to another Web page or another place in the same document 

when the user clicks on it. 

The following are the steps to create a Hyperlink. 

1. Select the text that is to be displayed as Hyperlink as 

shown in Fig.3-62. 

  Fig.3-62 Inserting a Hyperlink  
 

2. Click the Insert tab. 

3. Click Hyperlink in the Links group as shown in Fig.3-63. 

4. Click OK. 

There is also an easy way to create a Hyperlink to Web page. Type the Hyperlink text and 

press Spacebar or Enter key. 

Hyperlink appears in blue color and underlined. To open the Web page, position the mouse 

pointer over the Hyperlink and press the Ctrl key while clicking the mouse button. 

The text format of Hyperlink can be formatted to regular text, that is, it should not be in blue 

color or underlined. To remove the text format of Hyperlink, Right-click the Hyperlink and select 

Remove Hyperlink from the shortcut menu. 



  97  3 Office Automation 

 

Fig.3-63 Opening screen of Microsoft Excel 

3.2 SPREADSHEET 

Spreadsheet is used to store, organize, calculate and present numerical data in an easily 

understandable format. 

3.2.1 INTRODUCTION TO SPREADSHEET 

A spreadsheet is a grid of rows and columns in which user enters numbers and text. 

Spreadsheet programs are powerful multipurpose calculators, capable of everything from adding 

two plus two to solving problems that involve complicated calculations. Spreadsheet programs 

allow user to organize data, perform calculations, draw graphs of numeric data and develop 

professional looking reports. 

A common spreadsheet program is Microsoft Excel. It is a part of Microsoft Office 2010 

software. Therefore, use of Microsoft Excel 2010 will be explained. 

Opening the Microsoft Excel Program 

The following are the steps to open the Excel program. 

1. Turn on the computer and click Start button. 

2. Click All Programs. 

3. Click Microsoft Office to display the submenu. 

4. Click Microsoft Excel 2010 to open the Excel program. The opening screen of Excel will 

appear as shown in Fig.3-63. 
 

Identifying Cells 

The boxes formed by the intersection of individual rows and columns are known as cells. 

Cells are identified by the combination of their column letter and row number. For example, the 

sixth cell in the third column is known as cell C6. This is known as cell’s address. 

DO YOU KNOW? 

Microsoft was founded by Bill Gates and 

Paul Allen in April, 1975. 
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Fill Handle 

Active Cell 

At any moment user is positioned in a single cell known as active cell or current cell. Active 

cell has dark border as shown in Fig.3.63. When the user enters data, it goes in this cell. 

Excel Workbook 
Sheet Tabs 

When user starts Excel, it creates a new blank 

workbook, called Book1. A workbook contains sheets, 

each of which is called a worksheet. Excel opens a 

workbook with three worksheets as shown in Fig.3- 

64. 
 

 

 
  Fig.3-64 Sheets of Excel workbook  

 

Size of Spreadsheet 

DO YOU KNOW? 

Tip: You can rename a worksheet. For this, right click the 

sheet tab of the worksheet that you want to rename, select 

Rename in the shortcut menu, type a name and press Enter. 

Each worksheet in a workbook has 16,384 columns and 1,048,576 rows. Work area is like 

a movable window. The user can move the window sideways to view additional columns as well 

as up and down to view additional rows. 

Filling Columns and Rows 

The following are the steps to fill a series of numbers from 1 to 7. 

1. Enter 1 in cell A1 and 2 in cell A2 below it. 

2. Select the two cells, position the mouse pointer on the fill handle at the bottom right corner 

and drag it downwards through A7. 

3. The cells will be filled with series from 1 to 7. 

4. You can open the drop-down menu at the bottom right corner as shown in Fig.3-65 and select 

another option. 

 

  Fig.3-65 Filling a series in cells in rows  



  99  3 Office Automation 

 

Fig.3-66 Filling cells with odd numbers in columns 

Fig.3-67 Entering formula in worksheet 

Cells are filled with odd numbers in Fig.3-66 by entering 15 in cell A3 and 17 in cell B3 and 

then dragging the fill handle to cell F3. 
 

Relative Cell Addressing 

In Excel, cell addresses included in a formula or function are relative cell addresses. 

Relative cell address means when a formula is copied to other cells, the cell references in the 

formula change to reflect the formula’s new location. 
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To understand relative addressing, consider the worksheet shown in Fig.3-67. 

 Enter the formula =B5+C5+D5 in cell E5 to calculate the total number of Acer laptop 

computers sold in the first quarter. 

 Copy the formula in cell E6. 

 The formula in cell E6 

becomes =B6+C6+D6 as 

shown in Fig.3-68. 

 The cell references have 

automatically changed based 

on the relative position of row 

and columns because relative 

cell addressing is used in 

formula in cell E5. 

 Similarly, the formula will 

become =B7+C7+D7 in cell 

E7   and   in   cell   E8   it  will 

become  =B8+C8+D8. This is 
  Fig.3-68 Copying formula to another cell  

 

 
Absolute Cell Addressing 

what is required in this 

worksheet. 

User can address a particular cell location no matter where the formula appears by 

using absolute cell address. Absolute cell addressing keeps a cell reference constant when 

copying a formula or function. Absolute cell addresses begin with a dollar sign in the formula, 

such as =$C$5 + $D$5. 

 

  Fig.3-69 Using absolute cell addressing in formula  
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Fig.3-71 Using Paste Special command 

In the worksheet of Fig.3-69, sales tax is calculated as 6% for software items. Absolute cell 

addressing is used for the cell C3 in the formula =C6*$C$3 in cell D6 for calculating sales tax 

because it should not change when the formula will be copied to cells D7, D8 and D9 as shown 

in Fig.3-70 . 
 

 
Paste Special 

  Fig.3-70 Copying formula that has absolute addressing  

Excel copies all the information in the selected range of cells when you paste data. Excel’s 

Paste Special command allows many 

other options while pasting cells such 

as paste only formats of selected cells 

without contents or paste contents 

without formulas. 

The following steps describe the use of 

Paste Special command. 

1. Select the cell range to paste. 

2. Open the Paste drop-down menu in 

Clipboard group of Home tab and 

select Paste Special as shown in 

Fig.3-71. Paste Special dialog box 

will open. 
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3. Select an option from the Paste Special dialog box shown in Fig.3-72 and click OK. 
 

  Fig.3-72 Paste Special dialog box  

 
 

 

  Fig.3-73 Formula in cell D6 is formatted  

 
 
 
 
 
 
 
 
 
 
 
 
 

 
 Fig.3-74 Formula in cell D6 is copied to cell D7, D8 and D9 

Commonly used options of Paste 

Special dialog box are explained 

below. 

All: Used to paste all the information in 

the selected cell range. This is same as 

normal paste command. 

Formulas: Used to paste text, numbers 

and formulas without formatting. 

The formula in cell D6 in the 

worksheet shown in Fig.3-73 is 

formatted. When this formula is copied to 

cells, D7, D8 and D9 using paste special, 

the format of cell D6 is not copied as 

shown in Fig.3-74. 

Values: Used to convert formulas in the 

selected cell range to their calculated 

values and then apply the paste 

command. 

Formats: Used to paste only the 

formatting of selected cell range without 

cell contents. 
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All except borders: Used to paste all the information in the selected range without copying any 

borders if used. 

3.2.2 WORKING WITH FUNCTIONS AND FORMULAS 

Working with Functions 

Functions are built-In formulas in Excel that allow user to easily perform common 

calculations on data. Functions can be entered in a worksheet using keyboard, Insert Function 

command or AutoSum drop-down menu. 

 Using Keyboard to Find Average 

The following are the steps to calculate average sale for Acer laptop computer during the 

first quarter using the AVERAGE function. 

1. Select cell E5 where the result will appear. 

2. Type =av to display the Formula AutoComplete list as shown in Fig.3-75. 
 

  Fig.3-75 Calculating average  

3. Point to AVERAGE function and Double-click. 

4. Select the range B5:D5 to insert it as argument to the AVERAGE function. 

5. Press Enter key. 

 Using Insert Function command to Find the Highest Value 

The following are the steps to find the highest value. 

1. Select cell B11 where the answer will appear. 

2. Click Insert Function command shown in Fig.3-76. Insert Function dialog box will be 

displayed. 

3. Select MAX in the function list and click OK. 
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Insert Function command 

4. Type B5:B8 in the Number 1 text box of Function Arguments dialog box and click OK. 
 

  Fig.3-76 Using Insert Function command to insert a function  

 

 Using AutoSum Drop-down Menu to Find 

the Lowest Value 

The following are the steps to find the lowest 

value in the range B5:B8 using AutoSum drop- 

down menu. 

1. Select cell B12 where the answer will appear. 

2. Click Formulas tab. 

3. Open the AutoSum drop-down menu in the 

Function Library group as shown in Fig.3-77 

and select Min. 

4. Type the range B5:B8 and press Enter. 

Working with Formulas 

A formula is an expression that performs 
  Fig.3-77 Using AutoSum command  calculations. It consists of operators, constants and 

cell addresses. The standard operators used in Excel formulas are given in Table 3-78. 
 

Arithmetic Operation Excel Operator 

Addition + 

Subtraction . 

Multiplication * 

Division / 

Exponent ^ 

    Table 3-78 Arithmetic operators used in Excel  
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All the Excel formulas begin with equal sign (=) just like functions. For example, to 

multiply two numbers 4 and 7, the 

formula will be =4*7. User can also use 

cell   addresses  in   formulas   such as 

=(A4+B4)/5. This formula will first add 

the contents of cell A4 and B4 and then 

divide the sum by 5. 

Following are the steps to calculate 

the total number of laptop computer sale 

for the months of January, February and 

March in the worksheet shown in Fig.3- 

79.  Fig.3-79 Using formula to find sum  

1. Click cell B9 where the answer will appear. 

2. Type the formula =B5+B6+B7+B8 as shown in Fig.3-73 and press Enter. 

3. To calculate the total number of laptop computers sold in the months of February and March 

copy the formula from cell B9 to C9 and D9. 

4. Click the cell B9, point to the fill handle and drag it through cell D9. 

The user can also calculate the total number of laptop computers sold in January by 

performing the following steps. 

1. Click cell B9. 

2. Click Formulas tab. 

3. Double-click the AutoSum command in the Function Library group. 

Excel Automatically Recalculates Formula Results 

Whenever the user changes the value in a cell, the result of the formula in which that value 

is used will be automatically updated. This feature known as automatic recalculation is one of 

the main advantages that spreadsheets have over calculators. 

3.2.3 GRAPHICAL REPRESENTATION OF DATA 

A chart is used to 

represent data graphically. 

Charts are very helpful in 

explanation and representation 

of data. A commonly used chart 

is the column chart. Therefore, 

creation of this chart will be 

described for the worksheet 

shown in Fig.3-80. 
  Fig.3-80 Half yearly sale of laptop computers  
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Fig.3.82 Column chart 

 
Tip: To select a predefined chart 

style, click the chart that you want 

to format. This will display Chart 

Tools. On the Design tab, in the 

Chart Style group, select the chart 

style. 

Creating a Column Chart 

The following are the steps for creating a column chart. 
 

  Fig.3-81 Selected cell range for column chart  

 

 
The chart shown in Fig.3-82 will appear on the screen. 

 
 
 
1. Select the cell range (source data) 

as shown in Fig.3-81 that you 

want to represent in the column 

chart. 

2. Click Insert tab. 

3. In the Charts group, open the 

drop-down menu of Column 

command. 

4. Select a chart from the menu. For 

example, the chart on the top left 

corner of menu. 

 
 
 
 
 
 
 
 

 

Following are the steps to give 

titles to the chart and horizontal 

and vertical axis to make it 

more meaningful. 

1. Click anywhere in the 

chart to make the Chart 

Tool tabs appear in the 

Ribbon. 

2. Click Layout tab as 

shown in Fig.3-83. 
 

 

  Fig.3-83 Layout tab of Chart Tools  

Tip: To only print the chart in a 

worksheet, click anywhere in 

the chart and give the print 

command. 
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3. Click Chart Title in 

Labels group and select 

Above Chart. 

4. Type the chart title in the 

text box. 

5. Click the Axis Titles 

command, select 

Primary Horizontal 

Axis Title and select 

Title Below Axis. 

6. Type the horizontal axis 

title in the text box. In the 

same way give a title to 

the vertical axis. The 

resulting chart is shown 

in Fig.3-84 

 

 

  Fig.3-84 Column chart after labelling  

 

3.2.4 MANIPULATING AND FORMATTING DATA 

Filtering Data 

Filtering data means displaying 

only the information that the user 

needs based on a condition. For 

example, user could filter a list of 

students for viewing who belong to a 

particular class. User could also 

filter a list of people whose ages are 

above 30. 

The following are the steps to filter a 

list of students who belong to class 

IX.B. 

1. Select the rows you want to filter 

including the header row as shown 

in Fig.3-85. 

2. Select the Data tab on the Ribbon. 

 
  Fig.3-85 Data selected for filtering  

3. Click the Filter command in the Sort and Filter group. 

4. Drop-down arrows will appear in the header of each column. 
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  Fig.3-86 Selecting filter condition  
 

Data Validation 

5. Click the drop-down arrow for class column. The 

filter menu will appear as shown in Fig.3-86. 

6. Uncheck the boxes next to (Select All), IX.A and 

IX.C. 

7. Check the box next to IX.B. 

8. Click OK. Only the information of students who 

belong to class IX.B will be displayed. The other data 

will be temporarily hidden. 

The following are the steps to clear the filter. 

1. Click the drop-down arrow in the Class column. 

2. Click Clear Filter From “Class”. 

3. Click Filter Command in the Ribbon. 

Data validation is used to control the values or the type of data that user enters into a cell. 

The following steps will define criteria for entries in class column of student worksheet to 

IX.A, IX.B and IX.C. If the user enters any other data, an error message will appear. 

1. Create a list of valid entries in the worksheet that contains the data IX.A, IX.B and IX.C. 

2. Select all the cells in Class columns without the column header. 

3. Click the Data tab on the Ribbon as shown in Fig.3-87. 
 

  Fig.3-87 Using Data Validation command  
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4. Click Data Validation 

command in the Data Tools 

group. Data Validation dialog 

box shown in Fig.3-88 will 

appear. 

5. Click the drop-down arrow 

below Allow heading and select 

List. 

6. Click the button on the right side 

below Source. 

7. Select the cell range that 

contains the list of valid entries 

and click Close. 

8. Click OK to apply validation. 

As another example, restrict 

data entries in the Age column to 

ages between 13 to 17. 

1. Select all the cells in Age 

column without the column 

header. 

2. Click Data tab on the Ribbon. 

3. Click Data Validation command 

in the Data Tools group. Data 

Validation dialog box will 

appear. 

4. Click the drop-down arrow 

below Allow. 

5. Select Whole number from the 

menu as shown in Fig.3-89. 

 

 
 

 
 

 

  Fig.3-89 Data Validation dialog box  

6. Enter 13 for the minimum value and 17 for the maximum value. 

7. Click OK to apply validation. 

Protecting a Worksheet 

When a worksheet is protected, other users can only view the information in it but changes 

cannot be made. 

The following are the steps to protect a worksheet. 

Fig.3-88 Data Validation dialog box 
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1. Click Review tab in the Ribbon. 

2. Click Protect Sheet command in the Changes group. 

3. Enter a password and click OK. 

4. Reenter password to confirm and click OK. 

Unlocking Cells 

Generally the user would not like to prevent changes to the entire worksheet. The user may 

want to allow other users to make 

changes in worksheet data but 

prevent changes to titles and 

formulas. For this, unlock the cells 

in which data editing is to be 

allowed. 

The following are the steps to 

unlock cells. 

1. If your worksheet is protected, 

click the Unprotect Sheet 

command in the Changes 

group on the Review tab. 

2. Select the cells you want to 

unlock. 

3. Press    Ctrl+1    to    open the 

Format  Cells  dialog box and 

  Fig.3-90 Format Cells dialog box  click the Protection tab as 

shown in Fig.3-90. 

4. Click the Locked check box to remove its check mark and click OK. 

5. Protect the worksheet as explained earlier. 

Conditional Formatting 

Excel provides commands to apply formatting to one or more cells based on the value of the 

cell. This is known as conditional formatting. User can apply one or more rules to cells such as 

if the value in the cell is less than 33 then color the cell red. The advantage of applying such 

rules is that the user can easily view which cells have value less than 33. 

The following steps will 

color the text red with light 

red background in cells 

that have value less than 

33 in the worksheet shown 

in Fig.3-91 

  Fig.3-91 Result sheet of students  
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1. Select the cells to which you want to apply conditional formatting. 

2. Click Home tab on the Ribbon. 

3. Click Conditional Formatting command in Styles group to open the drop-down menu and 

select Highlight Cells Rules as shown in Fig.3-92. 
 
 

 
Less Than command 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

  Fig.3-92 Conditional Formatting  

 

4. Select Less Than in the submenu. 

5. Enter 33 and select Light Red Fill with Dark Red Text in Less Than dialog box to view the 

failing marks in red color with light red background as shown in Fig.3-93. 

6. Click OK to apply the formatting. 
 
 
 
 

  Fig.3-93 Worksheet after conditional formatting  
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Fig.3-94 Opening Inpage 

Program 

Paragraph 
Align 
Tool Bar 

Graphical 
Shapes 
Tool Bar 

Document Window 

Vertical 
Ruler 

3.3 URDU EDITOR 

3.3.1 INTRODUCTION TO INPAGE URDU EDITOR 

Inpage is widely used Urdu language editor introduced in 

1994. It runs on Windows operating system and it is used for creating 

documents in Urdu/Arabic languages, etc. It provides all the standard 

formatting and editing tools available in word processors used for 

creating documents in English. It is easy to learn and use. Inpage 

allows user to create wide variety of documents such as letters, 

reports, books, magazines, newspapers and brochures in Urdu. Urdu 

word processing is now available in MS Word. That option may be 

used. Next year you may learn MS Word Urdu using the language 

bar in windows 7 onward. The language shift programming is called 

localization. It was done by National Language Authority Pakistan 

and Inksoft, Islamabad under the guidance of Dr. Attash Durrani. 

Opening the Inpage Program 

The following are the steps for opening the Inpage program. 

1. Turn on the computer and click Start button. 

2. Click All Programs. 

3. Click Inpage 2009 Professional to display the submenu. 

4. Click Inpage 2009 as shown in Fig.3-94. The opening screen of Inpage will appear as shown 

in Fig.3-95. 

Title Bar Menu Bar Formatting Tool Bar Horizontal Ruler 

  Fig.3-95 Opening Screen of Inpage Urdu Editor  
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Fig.3-99 Keyboard Preference dialog box to select 

a keyboard 

3.3.2 MANAGING A DOCUMENT IN INPAGE 

Creating a New Document 

1. Click the File tab. 

2. Click New in the pull-down 

menu as shown in Fig.3-96. 

3. New Document window will 

appear as shown in Fig.3-97. 

4. Set the Page, Margins and 

Columns setting and click 

OK. 

5. Now, type the text in Urdu. 

Selecting a Keyboard 
Layout 

1. Click Edit to open 

the Edit pull-down 

menu. 

2. aClick 

Preferences to 

open the submenu 

and select 

Keyboard 

Preferences as 

shown in Fig.3-98. 

  Fig.3-96 File tab    Fig.3-97 New Document window  

 

 

3. Select a keyboard 

from the Keyboard 

Preferences 

window shown in 

Fig.3-99 and click 

 
 
 
 
 
 

  Fig.3-98 Selecting a keyboard layout  
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OK. User can also view the keyboard layout as shown in Fig.3-100 by clicking the view 

option. 
 
 
 
 

(a) 
 
 
 

 

(b) 
 

  Fig.3-100 Keyboard layout of (a) Monotype and (b) Phonetic Keyboard  
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Opening a Document 

1. Click the File tab. 

2. Click Open. The Open Document dialog 

box shown in Fig.3-101 will appear. 

3. Select the document 

4. Click Open. 

An Urdu document prepared in Inpage 

program is shown in Fig.3-102. 

  Fig.3-101 Open Document dialog box.  

  Fig.3-102 Urdu document  

Saving a Document 

1. Click File tab. 

2. Select Save or Save as. Save Document 

As dialog box shown in Fig.3-103 will 

appear. 

3. Select the folder where document is to be 

saved. 

4. Give a file name to the document. 

5. Click Save. 

3.3.3 FORMATTING DOCUMENT 

Copying or Moving Text   Fig.3-103 Save Document As dialog box  

1. Select the text to copy or move by dragging the mouse pointer. The selected text will be 

highlighted. 

2. Click Edit to open the Edit pull-down menu as shown in Fig.3-104. 

3. Select Copy or Cut. 
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Fig.3-104 Text selected for copying 

4. Position the mouse pointer at the location where the text is to be copied or moved. 

5. Open the Edit menu and click Paste. 
 

The shortcut commands Ctrl+C, Ctrl+X and Ctrl+V can also be used for Copy, Cut and 

Paste respectively. 

 

  Fig.3-105 Document after copying the text  
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Deleting Text 

To delete text, select the text as shown in Fig.3-106 by dragging the mouse pointer and 

then press the Delete key. 
 

  Fig.3-106 Text selected for deletion  
 
 

  Fig.3-107 Document after deleting the text  
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Changing Language 

The following are the steps for changing to English language. 

1. Click Language in Menu Bar as shown in Fig.3-108. 

2. Click Toggle Language. 

3. Perform the same steps to return back to Urdu typing. 

 
 

 
Language Menu 

  Fig.3-108 Changing language  



  119  3 Office Automation 

 

Formatting Text 
 
 

 

  Fig.3-109 Text Formatting Tools  

Select the text and apply the appropriate commands given in Fig.3-109. Text with different 

formatting is shown in Fig.3-110. 
 
 
 

  Fig.3-110 Formatted text  
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  Key Points  
 

 Word processing refers to the use of computer to create, edit, format and print documents. 

 A word processor is computer application software that is used for the creation of 

documents on computer. 

 Ribbon is located below the title bar of Word window and it consists of tabs, groups 

and commands. It provides access to commands that are needed while working on a 

document. 

 Page break is a marker that tells Word program that the contents which follow are to appear 

on a new page. 

 Section break inserts a new page but it allows the user to change the page format without 

having any effect on the formatting of the previous pages. 

 Header refers to information that appears at the top of a page and footer to information that 

appears at the bottom of a page. 

 WordArt is a text modifying feature in Word to create decorative effects such as shadow, 

colors, 3D effects, changing shape of text, etc. 

 Hyperlink is text in a Web page or document that links to another Web page or another 

place in the same document when user clicks on it. 

 Spreadsheet is a grid of rows and columns in which user enters numbers and text. 

 A workbook consists of sheets, each of which is called a worksheet. Excel opens workbook 

with three sheets but user can add additional worksheets if required. 

 Relative cell address means when a formula is copied to other cells in Excel, the cell 

references in the formula change to reflect the formula’s new location. 

 Absolute cell addressing keeps a cell reference constant when copying a formula or 

function. 

 A chart is a used to represent data graphically. It helps in explanation and communication 

of the meaning of data in a worksheet. 

 Filtering data means displaying only the information that is needed based on a condition. 

 Data validation is used to control the values or the type of data that user enters into a cell. 

 Conditional formatting means applying a particular format to one or more cells based on 

the value of the cell. 
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  Exercise  
 

Q1. Select the best answer for the following MCQs. 

i. Which of the following software is used for creating professional documents? 

A. Spreadsheet Software B. Word processor 

C. Typing Tutor D. Both A and B 

ii. Which of the following tab of Word Ribbon contains Clipboard group? 

A. Page Layout B. Insert 

C. File D. Home 

iii. By default how many tabs are there in Word Ribbon? 

A. 7 B. 8 

C. 9 D. 10 

iv. What is used for creating decorative effects in Word? 

A. Paragraph formatting B. Text formatting 

C. Page formatting D. WordArt 

v. Which of the following tab contains the commands for creating charts in Excel? 

A. Home B. Formulas 

C. Insert D. Data 

vi. Which of the following command in Excel allows the user to view only certain data in a 

worksheet based on a condition? 

A. Data validation B. Data filtering 

C. Conditional formatting D. Data manipulation 

vii. Which of the following command in Excel restricts user from entering wrong data in cells 

of a worksheet? 

A. Data validation B. Data Filtering 

C. Conditional formatting D. Data manipulation 

viii. Which of the following command is used to apply formatting to one or more cells based 

on the value of the cell? 

A. Data validation B. Data filtering 

C. Conditional formatting D. Data manipulation 

ix. Which of the following shortcut keys are used for pasting selected text? 

A. Ctrl+C B. Ctrl+X 

C. Ctrl+V D. Ctrl+P 

x. When the mouse pointer is at extreme left and changes to a right-pointing arrow, which 

of the following command is used in Word to select the entire document? 

A. Double-click B. Triple-click 

C. Ctrl+Single-click D. Shift+Single-click 
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1. Type the following text and apply the commands given at the end. 

COMPUTER ETHICS 

Computer ethics is concerned with the moral guidelines for the ethical use of computer 

technology. It emerged with the invention of computer. It specifies what is right and what 

is wrong when using computer technology. The following are some important points of 

computer ethics. 

Computer should not be used to harm other people 

Computer should not be used to commit any type of crime 

Computer users should not create computer virus 

a. Center the title and make it bold 

b. Apply font size 16 to the title 

c. Justify the paragraph 

Q2. Write short answers of the following questions. 

i. What is a word processor? Write some advantages of it over a typewriter. 

ii. Name any three types of documents which can be prepares in Word. 

iii. Differentiate between page break and section break. 

iv. Why header and footer are important in a Word document? 

v. What is the purpose of control buttons in Word window? 

vi. Why hyperlinks are created in Word document? 

vii. Name any three areas of application of Excel. 

viii. Differentiate between relative and absolute cell addressing in Excel. 

ix. What are the advantages of protecting an Excel worksheet? 

x. How graphical representation of spreadsheet data can be helpful in business. 

Q3. Write long answers of the following questions. 

i. Which shortcut keys are used in Word to move cursor to the beginning of line, end of line, 

top of the document and end of the document? 

ii. Write the mouse commands used for selecting various items is a Word document such as 

single word, sentence, paragraph, etc. 

iii. Explain text and paragraph formatting in Word. 

iv. Describe the Paste Special command used in Excel. 

v. Describe how functions are used in Excel with examples. 

vi. Describe how formulas are used in Excel with examples. 
 
 
 
 

  Lab Activities  
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d. Underline and bold the words “Computer ethics” in the paragraph 

e. Apply italics and bold to the words “computer technology” 

f. Apply bullets to the last three lines 

2. Create weekly timetable of your class in Word and give title to it using WordArt. 

3. Create the following worksheet in Excel and calculate sum and average using 

formulas. 
 

Expenses of 1st Quarter 

S.No. Expense Jan Feb Mar Total Average 

1. Salary 87000 102400 113800   

2. Rent 2500 2500 2500   

3. Utilities 3250 3500 3080   

4. Transport 7830 6885 8940   

5. Miscellaneous 4500 6708 7740   

4. Create a column chart for expenses in the months of January, February and March 

for the above worksheet. 

5. Create the following worksheet in Excel and enter marks in the subject columns in 

the range 0 to 75. Restrict data entries in the subject columns to the specified range 

using data validation command. 
 

S.No. Student Name Mathematics Physics Computer Chemistry 

1. Abrar Nabi     

2. Mumtaz Akbar     

3. Muhammad Bilal     

4. Javed Akhtar     

5. Afzal     

6. Muslim Khan     

6. Write a leave application in Urdu using the Inpage Urdu editor. 


